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Experiment 1

Introduction to Computer Tools
and Uncertainties

1.1 Objectives

e To become familiar with the computer programs and utilities that will
be used throughout the semester.

e To become familiar with experimental uncertainties.

1.2 Introduction

Microsoft Excel is a spreadsheet program that allows you to manipulate text
as well as data. Most importantly for the labs you will be doing, Excel can
perform calculations quickly that would otherwise be very time consuming.
Learning a few basic commands and skills in Excel now will save you a
considerable amount of calculation time the rest of the semester.

Once you have the data and computations from Excel, you can make a
graph that will quickly and easily show what trends or relations the data
exhibits. Kaleidagraph is a versatile graphing program and allows you
complete control over how the data will be presented. It is up to you to
decide as to what kind of graph will be best, though you will often be given
guidance, especially for the first few experiments.



1. INTRODUCTION TO COMPUTER TOOLS AND UNCERTAINTIES

1.3 Miscellaneous comments

e Always bring a flash drive with you to class and save your work often.
When the computer restarts, it erases all changes to the hard drive.

e The Excel spreadsheet is made up of rectangles called cells.

e Kaleidagraph is a graphing program that you will use to analyze the
data we compute in the Excel spreadsheet.

1.4 Theory

Uncertainties

When we make a measurement, we need to know how precise that mea-
surement is. The amount of precision of the measurement is called the
uncertainty — we need to be able to report how uncertain we are about
a measurement that we have taken. For example, if I measured how long
my finger was with a ruler, I might say that my finger was measured to be
9.5+0.5 cm — that is, I'm confident that it is actually between (9.5—0.5) cm
and (9.5 + 0.5) cm.! This is a lot more meaningful of a statement than if I
measured 9.5 & 5.0 cm. I wouldn’t know much about my finger length at all,
and finding gloves that fit would be a nightmare!

An oft-used synonym for “uncertainty” is “error”. Here, “error” does not
mean a mistake, but rather a physical inability to make perfect measurements.
All measurements are to some extent imperfect, and therefore the results
obtained are always subject to some uncertainty. The scientist must indicate
the magnitude of these uncertainties.

We express the uncertainty of a quantity x by writing x 4+ dz, where dz
is the uncertainty of z. Note that even though “dz” has two characters, we
treat it as one variable, not “0” multiplied by “x”. Uncertainties are always
positive numbers, and they always have the same units as the quantity in
the equation (2 meters + 2 seconds doesn’t make much sense!).

IThere is a more rigorous definition of uncertainty and confidence, but we will not
use it in this course.
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1.4. Theory

Random Errors

When you make a series of measurements of the same quantity using the same
measuring instruments, you often find that you do not obtain exactly the
same answer each time. Your measurements are said to be affected by random
errors. Random errors arise from small, uncontrollable differences in the way
each measurement was made, and the differences make the measurement fall
either above or below the true value, with equal probability. Random errors
determine the uncertainty in the value of a directly measured or calculated
quantity.

Systematic Errors

Unlike random errors, systematic errors tend to make each of your measure-
ments be off in the same direction. For example, if you weighed a series of
rocks on a scale, and put them on a plate each time, then you’d be measuring
the weight of the plate as well each time, making the scale read higher than
the actual weight of the rocks every time.

Such errors can result from either improper calibration of the equipment
or from a failure to account properly for some unexpected perturbation
such as friction. These errors are generally harder to estimate than random
errors, though they can be predicted more easily, as in the case of the plate.

Some general rules about uncertainties

Appendix A contains a more detailed reference guide to uncertainties, but
here is a summary:

e An uncertainty is always a positive number, dx > 0.

e If the uncertainty of x is dx, then the fractional uncertainty of z is

dx/x.
e If the fractional uncertainty of x is 5%, then dx = 0.05z.

e If you measure x with a device that has a precision of u, then dx is
at smallest as large as u (you might make your reported uncertainty
larger to account for some other difficulty in measurement).
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1. INTRODUCTION TO COMPUTER TOOLS AND UNCERTAINTIES

e If you add or subtract two quantities with uncertainties, the uncertain-
ties add to give the uncertainty of the result (since they could both
be wrong in the same direction lower or higher than the true value).
Soif z=x +y orif 2 =2 — y, then §z = dx + Jy.

e if d is your mesaured value (“data”) and e is the expected value,

— The difference is D = d — e.
— % difference is D/e x 100%.
— They are compatible if |D| < éd + de.

e If you multiply or divide two quantities with uncertainties, the frac-
tional uncertainties add to give the fractional uncertainty of the result
(contrast with adding or subtracting above). So if z = zy or z = x/y,
then 0z/z = dz/x + dy/y.

Graphs

It’s hard for people to read a table of numbers and see a pattern or trend.
Graphs allow mathematical relationships to be visualized and consequently
more clearly understood. Graphs also help in determining the mathematical
relationships between variables.

1.5 In today’s lab

You will learn to use Microsoft Excel and Kaleidagraph to perform some
simple tasks.

1.6 Equipment

e Data sheet. Before making your graph, record your data in a system-
atic form, showing the units and uncertainties for each measurement.
In this course, you will use an Excel spreadsheet to document your
data. This way there will be no confusion in your mind about what
point you are graphing.

¢ Graphing software. You will use Kaleidagraph to graph and analyze
your data.
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1.7. Procedure

e Choosing axes. If you are asked to graph a vs. b, the variable before
the “vs.”, a, goes on the vertical axis, and the variable after the “vs.”,
b, goes on the horizontal axis. Label both your axes (showing units)
and title the entire graph (at the top), so readers can identify what
you are plotting.

e Choosing scales. The range of the scales should be chosen so that
you can easily see any meaningful variation in the data, but random
errors are not magnified out of proportion to their significance. Your
axes need not always begin at zero, but consider carefully whether
they should (Is zero a physically relevant point for the experiment?).

e Error bars. Wherever possible, indicate the uncertainty of each point
by using error bars. An error bar is a line passing through the data
point and extending from the smallest value which that point could
reasonably have, up to the largest value it could have. An error bar
parallel to the vertical axis shows the uncertainty in the variable on
that axis, and an error bar parallel to the horizontal axis shows the
uncertainty in the variable on that axis. In most cases you will have
uncertainties in only one of your variables. Your instructor will tell
you when error bars can be omitted in a variable.

e Finding the best straight line through a set of data points.
KaleidaGraph can be used to fit a straight line to your data, complete
with the equation of this best fit line. In addition, KaleidaGraph will
provide an estimate in the uncertainty in the slope and y-intercept of
your best fit line.

1.7 Procedure

Part 1: Graphing data points

In this part of the experiment, you will use Excel and Kaleidagraph to graph
the x and y positions of a projectile as they change with time.

Entering data and formulas into Excel

1. Open the lab folder titled Introduction to Computers, which is in
the 251 Lab folder on the computer’s desktop. Remember, you can
open the folder by double-clicking on the icon with your mouse.

Last updated May 8, 201/ 5
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INTRODUCTION TO COMPUTER TOOLS AND UNCERTAINTIES

2. Double-click on the Excel file.

3. In the lower left hand corner of the spreadsheet window, click on the

tab labeled PART 1.

You should see two data tables on the spreadsheet. The first data
table is used to define the acceleration due to gravity, g, the initial
horizontal and vertical coordinates of the object’s position (2 and yq),
and the corresponding initial velocities (v, o and vy ). The second
data table will be used to display the x and y locations of the object
at various times.

. Fill in the first column of the second data table with times ¢ = 0.0s

through ¢ = 3.0s in increments of 0.1s. Do not waste time filling in
each of these values by hand — instead, let Excel do the work for you.
Here’s how:

a) In the first cell of the time column (cell B11), enter 0.

b) In the second cell of the column (B12), you can give Excel the
formula you want it to follow. In each cell in the column, we
would like Excel to add 0.1 seconds to the cell immediately above
it. So, in cell B12, enter =B11+0.1. The = lets Excel know the
cell contains a mathematical or logical operation. After entering
the formula, cell B12 should contain 0.1.

c¢) Click and drag the mouse to highlight the entire column of the
data table, starting with the cell that has the formula in it (B12),
open the Edit menu at the top of the screen, scroll down to £ill
and select down. The entire column should now be filled with
numbers from 0 to 3.0 in increments of 0.1. Alternatively, left
click the bottom right corner of a cell and fill down by dragging
the mouse down to lower cells.

5. If you are viewing a spreadsheet and you are not sure what formula

Excel is using for some calculation, you can click on the cell and the
equation will be displayed in the formula bar near the top of the screen.
Try it by clicking on cell B23 which should contain 1.2. In the formula
bar, =B22+0. 1 should now be displayed.

The location of the projectile depends on the initial conditions and
the acceleration due to gravity. The object’s position in the horizontal
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1.7. Procedure

10.

direction at time t is given by
T =10 + Vg0t (1.1)

and in the vertical by
1
Yy = Yo+ vyot — 597527 (1.2)

where ¢ is the acceleration due to gravity, 9.8 m/ s2. We would like
to use the same method here to calculate the values for the location
of the object (z and y values), as we did for the time values in the
second data table. However, you need to either redefine the names of
the cells containing g, g, Yo, vz,0, and vy o before using them in an
equation with the fill-down method, or explicitly reference these cells
in an equation. The method presented and used in this lab will be to
redefine the cells.

To start with, let’s redefine the name of the cell which will contain the
acceleration due to gravity. Right click on cell B4, and select ’define
name’ from the window that appears. A New name window should
open up.

Enter g into the top line in the new name window and select 0K. Now,
when referring to this cell in an Excel formula, you can just enter
g, and when the fill-down option is used, Excel will not change the
referenced cell like it did with the cells for time.

Redefine the cell names for C4, D4, E4, and F4 to x0, y0, vx0, and vyO
respectively.

We need to give numerical values to the acceleration due to gravity,
as well as the initial position and velocity. The acceleration due to
gravity is 9.8 m/SZ. Let’s put our object 20 m away from us and 15m
above the ground, with an initial horizontal velocity of 12m/s away
and initial vertical velocity of 10 m/s upwards. Enter each numerical
value (not including the unit) into its corresponding cell.

The next step is to enter the correct Excel formula to calculate the
positions z and y as a function of time. In order to do this, you need
to enter Eqs. 1.1 and 1.2 in Excel’s programming language. The Excel
formula for the position z, which should be entered in cell C11, is
=x0+vx0*B11.

Last updated May 8, 2014 7



1. INTRODUCTION TO COMPUTER TOOLS AND UNCERTAINTIES

11. Use the fill-down method to calculate the rest of the x positions.

12. The Excel formula for the position y, which should be entered into
cell D11, is =y0+vy0*B11-0.5%g*B11~2. Use the fill-down method
to calculate the other y positions. A reference to some useful Excel
equations can be found in Appendix B.

Transferring data to Kaleidagraph

Once your data table is complete, you are ready to transfer your data
into Kaleidagraph using the cut-and-paste method. If you cannot fix
something that broke in Kaleidagraph, sometimes you will need
to close and restart the program.

Here are the steps to transfer your data:

1. Highlight the area you want to move. Highlight only the data values.
Do not include any cells containing text, such as column headers. The
program will not make a graph for you if you do.

2. From the drop-down menu, choose Edit » Copy, or press Ctrl+C to
copy the highlighted text to the computer’s clipboard.

3. Open Kaleidagraph by double-clicking its icon on the desktop.
4. Click on the upper-left-most cell of the spreadsheet that appears.
5. Choose Edit » Paste from the drop-down menu, or press Ctrl+V to
paste in your data.
Graphing in Kaleidagraph

You are now ready to make a graph.

1. You can change the column names in Kaleidagraph by double-clicking
them after you've transferred the data. In this case, you should name
the first column “Time (s)”, the second column “X (m)” and the third
column “Y (m)”.

2. To choose the graph type, choose Gallery » Linear » Scatter. This
option is used to create a scatter-plot of the x and y coordinates of
the projectile. A plot window should open.
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We want to plot both the x position and y position versus time. This
means that we want both x and y to be on the Y-axis, and time to be
on the X-axis.?

. Click on the bubble under the X column for Time (s), the Y-column
for X (m) and the Y-column for Y (m).

. Click the New Plot button. This will create a scatter plot with time
plotted on the horizontal axis and both the x and y coordinates plotted
on the vertical axis.

Graphs should always contain proper labels. Each axis should be
labeled with the variable name and the units in parentheses, and the
graph itself should have a title.

. To change the label of the vertical axis, double click on it. An Edit
String window should appear. Change the text in the window to X
(m) and Y(m). The same method is used to change the horizontal
axis label and the graph’s title. The appropriate way to title a graph is
“what physical quantity is on the vertical axis” versus “what physical
quantity on the horizontal axis”. Include this graph with your lab
report.

Part 2: Analyzing the graph

The slope and y-intercept often have physical meaning, and we can use the
graphing software to calculate them. In this part of the experiment, you will
use Excel and Kaleidagraph to graph and calculate the slope and intercept
of a set of data. In addition, Kaleidagraph will provide an estimate of the
uncertainty in the slope and intercept.

Adding error bars

1. Click on the PART 2 tab near the bottom of your Excel spreadsheet.

You should find a data set of times and positions of a ball rolling across
a horizontal surface. You will also notice two empty data columns —
you’ll get to those shortly.

2 Apologies for the overused variable y, as it is used for both the vertical direction in
the graph and the vertical direction in the physical situation. Be careful about which
you are referring to.

Last updated May 8, 201/ 9
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. Transfer the data in the first two columns into Kaleidagraph and make

a position vs. time graph.

. When graphing data which include experimental uncertainties, you

should include error bars to help the reader understand how significant
the trend shown is. The experimental uncertainty in the position
of the object is given in your Excel spreadsheet. To add error bars,
select Plot » Error Bars. An Error Bar Variables window should
appear.

. Use your mouse to check the box under Yerr. An Error Bar Settings

window should now appear. Make sure the Link Error Bars box is
checked. Just above and just below the Link Error Bars box, you
should see two identical pull-down selection boxes. These allow you
to define the size of your error bars. Since you have the error bars
linked, you only need to change one of these, and the other will follow.
Clicking on one of these boxes will give you the choice of setting your
error bars as a % of the value, a fixed value, a standard deviation, a
standard error, or referencing them to a data column.

. For this exercise, choose Fixed Value from the drop down menu and

then enter the uncertainty given on your Excel spreadsheet in the
Fixed Error box.

. Click 0K and then click Plot. You should now have error bars on

all of your data points on your graph. For additional information on
estimating uncertainties in measurements, see Appendix A.

Note: The numerical value of the uncertainty used here
is for this example only and should not be used in subse-
quent labs requiring an uncertainty in a length or distance.
You will find your own uncertainties in those experiments.

Plotting a best-fit line

The next thing you will do is to have Kaleidagraph find and plot a best fit
line to your graph.

10
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1.7. Procedure

1. Select Curve Fit » General » fitl. A Curve Fit Selections
window will open, check the box and click 0K. Kaleidagraph will plot
a best fit line on your graph. Also, a small data table will appear on
your graph.

The equation of the line is represented as y=m1+m2+MO in this data
table, where y is the variable plotted on the vertical axis, MO is the
variable plotted on the horizontal axis, m1 is the coordinate where the
line crosses the vertical axis (sometimes referred to as the y-intercept)
and m2 is the slope of the line. The data table will display numerical
values for the slope and the intercept, as well as their respective
uncertainties (d(slope) and d(intercept)). The bottom two lines R and
Chisq are a measure of how well your data are represented by your
best fit line and will not be used in this course. Include this graph
with your lab report.

We'd like to get a visual representation of what is meant by the slope
and intercept errors given by the Kaleidagraph straight line fit. With
this in mind, we will use the slope, intercept (int) and their respective
uncertainties (d(slope) and d(int)), plot the lines with the largest
and smallest slope which could reasonably represent your data (by
reasonable we mean one uncertainty unit away from the best fit).

To do this, you will need to return to your Excel spreadsheet. The
equation corresponding to the largest reasonable slope is

Tlargest slope = (slope + dslope) x ¢ + (int — dint) . (1.3)
The equation corresponding to the smallest reasonable slope is

Tsmallest slope = (slope — dslope) X t + (int + dint) . (1.4)

2. Use these equations to generate data points in your Excel spreadsheet
for the lines of largest and smallest reasonable slope.

3. Transfer your largest and smallest reasonable slope data to your
Kaleidagraph data table. Make a new plot of your data. Your new
plot should include all three data sets. Specifically, your original given
data set, the data set for the largest reasonable slope and the data set
for the smallest reasonable slope.

Last updated May 8, 2014 11



1. INTRODUCTION TO COMPUTER TOOLS AND UNCERTAINTIES

4. Include error bars on the given data set only — do not include error
bars on your data points for the largest reasonable slope or smallest
reasonable slope.

5. Calculate best-fit lines for all three lines using the Curve Fit Linear
option, rather than fit1 that you used earlier. Instead of displaying
a box with parameters, it just displays the equations for each line.
Include this graph with your lab report.

You now have your data and three graphs. You should print out all of
your data tables and all of your graphs. These must be turned in to your
instructor at the end of the class session for grading. In addition, you should
include the answers to any required questions and hand written sample
calculations (one calculation for each operation done by Excel — i.e. one
example of Tlargest slopes ON€ example of gy allest slopes etc.).

1.8 Checklist

Remember to turn in:

1. Part 1 data table and formula view?
2. Graph for Part 1
3. Part 2 data table and formula view
4. First graph for Part 2
5. Second graph for Part 2

6. Answers to Questions

7. Sample calculations for each formula used in Excel

3Pushing the Ctrl+¢ keys will display the formulas for the entire spreadsheet (the
backquote (‘) is to the left of the number 1 on the US keyboard). Pressing these two
keys again reverts back to the calculated numbers.
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1.9. Questions

1.9 Questions

1. What is the slope of the best fit line of the data set from the first
graph of part 2 (whenever asked about a measured quantity, you
should always include both units and an uncertainty)?

2. What is the calculated y-intercept of the best fit line from your given
data set (no uncertainty of fit line parameters is necessary)?

Last updated May 8, 201/ 13



1. INTRODUCTION TO COMPUTER TOOLS AND UNCERTAINTIES

3. What is the equation of the line having the largest reasonable slope
for this set of data (no uncertainty of fit line parameters is necessary)?

4. What is the equation of the line having the smallest reasonable slope
for this set of data?

5. Do the lines of largest reasonable slope and smallest reasonable slope
fit the data well (i.e. do they pass through most of your error bars)?

14 Last updated May 8, 201/



Appendix A

Contents of a Lab Report

This is a general list of items and sections which should be included in every
lab report.

Data and Spreadsheet

Write your name and your lab partner’s name at the top of your
spreadsheet.

The spreadsheet should have the data columns labeled, including
units. Also, include a written sample calculation for each type of
calculation performed by Excel. Do not forget to include the equation
or constants used.

Include any additional calculations that the lab manual asked you to
do.

Include a print-out of the formula view of your spreadsheet; to go to
formula view: Ctrl+*

Fit Excel sheet to one page: go to File » Page Setup » Scaling:
Fit “1” page wide by “1” page tall.

Graphs

Along with every graph there needs to be an observation (~ 2 sentences)
as to the nature of the graphs. You could comment on how the curves

15



A. CONTENTS OF A LAB REPORT

behave, what interpretation can be drawn from them, etc. What can
we learn from this graph, or what message do you have for your reader
about it?

e Every graph should have the following:

13

. title (always “ ‘vertical axis’ vs. ‘horizontal axis’ ")

1

2. labeled axes with units

3. curve fit if appropriate

4. legend if needed

5. error bars when appropriate
6

. your observations

e An example of a graph is shown in Fig. D.1
Answers to questions
e Tear out the question pages and provide answers to them.

Ordering of Pages

1. Data (sample calculations, spreadsheets, formula view)

2. Answers to questions

16 Last updated May 8, 2014



Volune of water leaked through roof vs. time

Volume (L)

80

' m1 0.17086 | 0.011629
! : ; m2 | 0.0084286 | 0.0002558
02 - """""" r-----— Chisq | 0.0059543 NA |
‘ R| 099407 NA
0.1 | i i | | | |
0 10 20 30 40 50 60 70
Time (sec)

Figure A.1: The graph represents the volume of water leaking through a roof

versus time. The rate at which water penetrates the roof is 0.0084+0.003 L /s.
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Experiment 2

Reaction Time

2.1 Objectives

e Make a series of measurements of your reaction time.

e Use statistics to analyze your reaction time.

2.2 Introduction

The purpose of this lab is to demonstrate repeated measurements that do
not yeild identical results; but this variation can give uncertainties (dx).
Sometimes throughout life, we are given numbers which can carry meaning.
In science, we often take measurements of the same thing multiple times
and want to know how these measurements relate to each other. Today,
we will be looking at your reaction time, and will try to find your average
reaction time. After finding your reaction time you will find a measure of
how confident you are in this value and place your reaction times into a
predictable model

2.3 Key Concepts

In case you don’t remember your Physics I lecture material, you’ll need to
refer to the chapters in an introductory textbook to physics. Alternatively,
you can find a summary on-line at Hyperphysics.! Look for keywords: mean,

http://hyperphysics.phy-astr.gsu.edu/hbase/hph.html
19
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2. REACTION TIME

standard deviation, gaussian distribution

2.4 Theory

Two of the main purposes of this experiment are to familiarize you with
the taking of experimental data and with the reduction of such data into a
useful and quantitative form.

In any experiment, one is concerned with the measurement of some
physical quantity. In this particular experiment it will be your reaction time.
When you make repeated measurements of a quantity you will find that your
measurements are not all the same, but vary over some range of values. As
the spread of the measurements increases, the reliability or precision of the
measured quantity decreases. If the measured quantity is to be of any use
in further work, or to other people, it must be capable of being described in
simple terms. One method of picturing measured values of a single quantity
is to create a histogram.

The histogram is a diagram drawn by dividing the original set of mea-
surements into intervals or “bins” of predetermined size, and counting the
number of measurements within each bin. One then plots the frequency
(the number of times each value occurs) versus the values themselves. A
histogram has the advantage of visually presenting the distribution of read-
ings or measurements. Fig. 2.1 shows a typical histogram for a set of
observations. The histogram displays the number of measurements. For
example, the first bin has two measurements between 0.195 seconds and
0.200 seconds. When placing the values into bins, one systematically puts
values that occur on the bin limits into the next higher bin.

When analyzing data with a histogram, the distribution often times
suggests that there is a “best” or most likely value, around which the
individual measurements are grouped. From an intuitive approach one might
say that the best value is somehow related to the middle of the distribution,
while the uncertainty is related to the spread of the distribution. The
following formulas, which we will define, will in general only have significance
for symmetrical distributions. Using mathematical statistical theory it turns
out that the best value is nothing more than the arithmetic average or mean
of our measurements, which we will denote with the symbol: Z.

>
N

Best value = average = mean =7 =

20 Last updated May 8, 2014



2.4. Theory

Reaction Time
5 , !

Mumber of measurements in reaction time interval

014 nz 021 0.2z 023 nz4 0.24
Reaction Time (g)

Figure 2.1: Typical histogram (bin size = 0.005 seconds).
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2. REACTION TIME

where

Y rj=aitagtagt . tay

N is the total number of measurements and z; are the values of individual
measurements (i.e. z1, 2,3, etc.).

We now need to define a quantity that is connected with the width of
the distribution curve. We use a quantity that tells us how the individual
measurements deviate from the central (mean) value of the distribution.

This is called “standard deviation”, denoted by “s”, and is defined as
follows:

>o(x; —T)?
N -1

where

(@i =7 = (21 -7+ (12 -0 + (23— T)° + . + (ay — T)°

We are also interested in the uncertainty of . That is, by how much 7,
calculated for different sets of data, are likely to deviate from each other.
This uncertainty is characterized by s;,, the width of the experimental
distribution of values of ¥ or “standard deviation of the mean” which
is calculated by

5
Sm = ——
VN

Note: the larger the number of measurements made of a quan-
tity the smaller the random uncertainty associated with the mean
value.

If the number of readings is very high and the bins are small, the
histogram approaches a continuous curve and is called a “distribution curve”.
Many theoretical distribution curves have been defined and their properties
evaluated, but the one that is most significant in the theory of measurement
is the Gaussian or “Normal” distribution. If all of the experimental data
that you have obtained correspond to one and the same physical quantity,
then for very large number of measurements they will be described by the
Gaussian distribution with its peak at the average value 7.

22 Last updated May 8, 2014
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robability of a given value

p

X+5 X+ 28

=1

- 28 X-8

x|

Figure 2.2: Gaussian distribution curve.

Some of the properties of this continuous distribution are that it is
symmetric around a peak value and that it falls to zero on either side of the
peak, giving it a “bell shaped” appearance (see Fig. 2.2). We use the Greek
letter sigma “o” to represent the standard deviation when referring to a
Gaussian distribution and ”s” for the standard deviation calculated from
finite (limited) sets of observations (“s” is the best estimate of “o” for a
finite set of observations). When considering Gaussian distributions, the
area enclosed by the range +o0 around the peak will contain 68% of the area
of the curve (or 68% of the measurements). This means that an individual
measurement has a 68% chance of falling within a region +o¢ around the
peak, or “mean” value, of the distribution. An area bounded by the range
+20 will contain 95% of the area of the curve and therefore represent a 95%
chance that an individual measurement will fall within this region of the
distribution. This is illustrated in Fig. 2.2.
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2. REACTION TIME

2.5 In today’s lab

In today’s lab, you will be measuring your own reaction time and will use
the above statistical formulae to hopefully create a Gaussian distribution
of your reaction times. There should be sufficient time available to collect
data and do the complete lab for your partner and for yourself.

2.6 Equipment

e Stop watch. - To run the stop watch, press START to start and press
STOP or the red button to stop. In this lab, we will start the timer
using the red remote start button. After getting your measurement,
press the RESET button to return the timer to zero. It should be
noted that you can increase the precision of the timer by holding the
STOP button for 2 seconds. After increasing the precision of the timer,
the smallest increment of measurement will go from 0.001 seconds to
0.0001 seconds. To go back, simply hold STOP again for 2 seconds.

Figure 2.3: The stopwatch used for this experiment.
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2.7. Procedure

2.7 Procedure

Note: Before starting, please practice steps 1-3 a few times before recording
your data.

1.

10.

Put your finger on the STOP button while your partner takes the red
START button in the wired remote.

The partner with the START button will secretly start the timer.

Try and stop the clock as quickly as possible.

4

Record your time in the Time column of the “.xls” spreadsheet in the

Reaction folder and reset the timer.
Repeat steps 1-4 25 times.

On a separate sheet of paper, calculate (by hand) Z, s, and sy, for
N =5 trials. Be sure to show your work!

On the spreadsheet, calculate the mean by putting the equation
“=SUM(B12:B16)/5” in cell C19. Note that the “SUM” function can be
used to find the sum of a group of numbers, and that B12:B16 will
evaluate the sum from cell B12 to B16 (B12, B13, B14, B15, B16).
The mean is simply the sum divided by the number of values in that
sum (in this case we have 5 values). Make sure this value matches the
number you calculated by hand.

Now fill in column C using the formula “=(B12-$C$19)” in the cell
C12 and fill down. The use of $ in front of C and in front of 19
"locks” in the cell that has the mean value so that when you fill down,
that cell will not change in the formula. For example, when using
the fill down feature in excel, the next cell would have the equation
“=(B13-$C$19)”, and so on.

Fill in column D by putting “=C1272” in cell D12 and fill down again.
Note how this calculated value is used in the formula for standard

[P}

deviation “s”.

On the spreadsheet, calculate the standard deviation in the appropriate
cell by using the formula “=SQRT(SUM(D12:D16)/4)”. Here we have
that N = 5, so our denominator N — 1 = 4. Make sure this value
matches the number you calculated by hand!
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11.

12.

13.

14.

15.

16.

17.
18.

26

Now calculate the standard deviation of the mean in the appropriate
cell by using the formula “=C21/SQRT(5)”. Make sure this value
matches the number you calculated by hand.

Using the methods above and the equations from the Theory section of
this lab, fill in the remaining cells on the excel sheet. You do not need
to do hand calculations for N=10 and N=25! Your mean and standard
deviation of the mean should change as you add more samples to its
calculation, but the standard deviation should remain about the same.

Record your standard deviation in the box below for future reference.
You will need them in a later lab.

s =0t =

Transfer your data from column B into KaleidaGraph and plot a
histogram. Do this by going to Gallery » Stat and select Histogram.

Adjust the range of values shown on the x-axis such that the minimum
is a few hundredths lower than your lowest measured time and the
maximum is a few hundredths greater than your greatest measured
time. Do this by going to Plot » Axis Options » Limits, and enter
the correct values in their respective boxes.

Change the number of bins such that your histogram looks similar to
the one shown in Fig. 2.1. Do this by going to Plot » Plot Options »
Histogram » Specifying the Number of Bins, select Fixed, input
an appropriate integer number, and press 0K. Make sure most of the
bins are filled in so that there are not many gaps in your histogram.

Make sure your histogram is properly labeled and print.

Please label by hand the positions of Z, T + s, and T — s on your
histogram.
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2.8. Comparing Data

2.8 Comparing Data

It is often necessary to compare two different pieces of data or results of two
different calculations and determine if they are compatible (or consistent). In
just about every experiment in this course you will be asked if two quantities
are compatible or consistent. The following describes how to determine if
two pieces of data are consistent (or compatible). Use this procedure to
answer the question at the end and use it as a reference whenever you are
asked if two pieces of data are compatible or consistent. Let us denote the
pieces of data by di and dg. We'll arbitrarily set dg as our expected value,
‘e’ and dj as the data, ’d’. Then we’ll apply our usual formulas. If d = ¢
or d — e = 0, clearly they are compatible. We often use D to denote the
difference between two quantities:

D=d-e (2.1)

This comparison must take into account the uncertainties in the observa-
tion of both measurements. The data values are d+dd and e+de. To perform
the comparison, we need to find 0 D. §D is the uncertainty for the difference
between d and e as shown in formula 2.1. The addition/subtraction rule for
uncertainties is:

5D = bd + de (2.2)

Our comparison becomes, “is zero within the uncertainty of the difference
D?” This is the same thing as asking if:

ID| < 6D (2.3)

In Fig. 2.4 we demonstrate three possible cases (A, B, and C) involving
consistency checks. As we can see for all three cases, the value for d & dd is
1243 (d = 12 and dd = 3). But, as we can see for each case, the value for e
changes (e = 8,6, 5 respectively), while the value for de remains the same
(0e = 3). Case A is consistent as the error bars overlap, case B is consistent
as the error bars touch, and case C is inconsistent because the error bars do
not overlap or touch.

Equation 2.2 and 2.3 express in algebra the statement “d and e are
compatible if their error bars touch or overlap” (see Fig. 2.4). The combined
length of the error bars is given by Eq. 2.2. |D| is the separation of d and e.
The error bars will overlap if d and e are separated by less than the combined
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Figure 2.4: Visual representation of a consistency check.

length of their error bars, which is what Eq. 2.3 says. Using Fig. 2.4 and
the given equations, we can see that D = 4,6, 7 respectively and 6D = 6
for all cases. We can then see that |D| < 0D for cases A and B, so they are
consistent. However, for case C, we can see that |D| £ §D, so the values
are not consistent. Sometimes rather than a second measured value you are
comparing your data to an expected value. If this is the case, replace d £ dd
with e 4 de, where e & de is the expected value including its uncertainty. For
more information on using uncertainties to compare data, see section 4 of
Appendix A

2.9 Checklist

1. The filled spreadsheet and formula view.
2. The histogram.

3. Hand calculations.
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2.9. Checklist

4. Answered question sheet.
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2.10. Questions

2.10 Questions

1. For all of your 25 measurements indicate on your spreadsheet whether or
not each measurement lies between T 4+ s. How many trials would you have
expected to be within that range for a pure Gaussian distribution? How
many of your trials were in that range for your distribution? If you made
many sets of 25 trials of your reaction time, would there always be the same
number of trials in that range?
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2. REACTION TIME

2. Suppose your lab partner was talking to the students at an adjacent lab
table when you started the timer. As a result, the time registered on the
timer when it was stopped was 10 seconds. How many standard deviations
(s) from your mean value does this represent? Should you include this data
point with the rest of your data? Why or why not?

3. Compare the mean and standard deviation of N = 10 with those for N =5
and N = 25. Are the values the same? Why or why not? Explain.
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2.10. Questions

4. If you have already taken 25 measurements, how many more measurements
of reaction time would you have to take to reduce sy, by a factor of two,
assuming s does not change? Justify your response.

5. Two red blood cell counts are (4.52 +0.14) x 106%11; and (4.84 £ 0.18) x

1062%115. Would you conclude that these measurements are consistent with
being from the same human? Evaluate the difference and comment. (Use
the formulas outlined in the Comparing Data section). Would your answer
change if the second blood cell count is (4.87 + 0.18) x 106%11;?
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Experiment 3

Analysis of a Freefalling Body

3.1 Objectives

e Verify how the distance of a freely-falling body varies with time.

e Investigate whether the velocity of a freely-falling body increases
linearly with time.

e Calculate a value for g, the acceleration due to gravity.

3.2 Introduction

Everyday, you experience gravity. This happens because the Earth is so
massive, it pulls us down and keeps us on the ground. But happens when
we drop something? We notice that as this thing falls to the Earth, it moves
faster and faster until it hits the ground. From this we can tell that gravity
is accelerating the object the entire time the object is in freefall. Today,
we will measure how much gravity actually accelerates this object by using
the Behr Freefall apparatus and your mathematical skills.

3.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: gravity, velocity, and acceleration

lhttp://hyperphysics.phy-astr.gsu.edu/hbase/hph.html
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3. ANALYSIS OF A FREEFALLING BoDY

Electromagnet —\

—_—
Switch
w
— Cylinder
<«— HV Wire
Spark
<«—— Paper Spark Tape Switch
J_ HV Pulser
= L

Figure 3.1: Schematic of the Behr Freefall Apparatus.

3.4 Apparatus

A Behr Free-Fall Apparatus and Spark Timing System will be used in this
experiment. A schematic representation of the apparatus is shown above in
Fig. 3.1 and a digital photograph of the apparatus is shown in Fig. 3.2 on
the following page.
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3.4. Apparatus

Figure 3.2: Schematic of the Behr Freefall Apparatus.
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3. ANALYSIS OF A FREEFALLING BoDY

3.5 Theory

In this experiment a cylinder is dropped and a record of its free fall is made.
Before the measurement, the cylinder is suspended at the top of the stand
with the help of an electromagnet. When the electromagnet is turned off,
the cylinder is released and starts to fall. Simultaneously, the spark timer
starts to send high-voltage pulses through two wires which are stretched
along the cylinder’s path. At the time of each pulse a spark goes through
the wires and the cylinder, leaving a mark on the special paper tape that
lies between the cylinder and one of the wires. The time interval between
two adjacent sparks is constant and is denoted by the Greek letter tau “r”.
7 = 1/60 of a second. Measuring the distances between any two marks,
Ay, and knowing the time interval between the corresponding sparks, At, it
is possible to calculate the average velocity during this interval using the
formula

Ay
N

If At is small enough, we can assume that the velocity at any instant
within this interval is approximately equal to this average velocity. In the
case where acceleration is constant, the instantaneous velocity at the
middle of the time interval At is exactly equally to the average velocity of
the object during the time interval At.

In general, for the motion of a body with a constant acceleration a, the
velocity v is given by the equation

v (3.1)

v =at+ v (3.2)
where v is the velocity of the cylinder at ¢ = 0. Since in our case the body
is falling freely,

a=—g (3.3)

where g = 9.81m/ s2 is the magnitude of the acceleration due to gravity. The
negative sign in front of ¢ is to indicate that the direction of the acceleration
is in the negative direction (i.e. downward). Therefore it follows from Eq. 3.2
that for a freely-falling body

v=uvg—gt (3.4)
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3.6. In today’s lab

Thus g can be determined from a plot of v vs. ¢ since the slope of any
velocity versus time graph is just the acceleration. The obtained value of
g can then be compared with the known value of the acceleration due to
gravity. The position of the cylinder, y, as a function of time is given by the
standard equation for an object that is undergoing constant acceleration. If
at time ¢t = 0 the object has height yg and velocity in the vertical direction
V0, then this equation looks like

1
y = yo + vot — §gt2 (3.5)

3.6 In today’s lab

At the start of today’s lab, your instructor will demonstrate the operation
of the Behr Freefall apparatus. In the interest of saving time, you will be
supplied with a shock tape from the Behr freefall apparatus. On this tape,
you will then measure the distance between the “dots,” and using the given
7, you will calculate the value of acceleration for g.

3.7 Equipment

e Behr Freefall Apparatus
e Shock tape

e Meter stick

3.8 Procedure

1. Secure both ends of the shock tape to the desk using masking tape,
making sure that the shock tape is as flat as possible.

2. The “bottom” of the tape is defined as the end of the tape with the
largest, bold black dot, also where the dots become farther apart.
Starting from the third dot from the bottom, label each successive
point from #25 to #1 in descending order. It is ok if you have
unused marks left over. Point #25 will now be defined at y = 0 and
point #1 will be defined at ¢t = 0.
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10.

Using your meter stick, measure each point’s distance (in cm) from
y = 0 (point #25) and write it down on the shock tape.

Input your measured distances into excel paying special attention to
which point number you are putting the distance into. Also input a
reasonable uncertainty for your measurement in excel.

Input the correct times for each point using the given value of 7.

Calculate the instantaneous velocity v; for each point y;. Here we have
that v = %—Zt/ Ay for each point ¢ is defined as Ay =y, —y_, and
At is likewise defined as At =t , —t_1. For example, we can see
that

Y3 — Y1
= . 3.6
=" (3.0
Note that At will be the same value for each point, which happens to
just be 27. Please include at least 1 hand calculation for these values.

Now calculate the uncertainty for your velocity at each point using

the equation dv; = 6?y

[199%h]

Transfer your data columns for “Time”, “y”, and “v” into Kaleida-
Graph.

Make a graph for y vs. t. You do not need a best fit line or error bars
for this plot.

Make a graph for v vs. t. Be sure to include a best fit line and error
bars for v. Be sure to write in plot comments for both of your plots.
The error calculation is given in section 3.9.

3.9 Error Calculation

For each measured y; you assign an error based on how accurately you can
measure that point. This error is called dy. This error determines all other
errors in this lab. For this lab and for the following formulae it is assumed
that the error in 7 and m are zero.

There error in Ay at each point 7 is the same and is given by

40

5(Ay) = 20y (3.7)
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3.10. Checklist

The error in the speed at each point 7 is

_0(Ay) 20y (Ay)26y Oy
d(vy) = vy Ay = vy Ay 27(Ay) = (3.8)

3.10 Checklist

1. Your spreadsheet and formula view.
2. Sample calculations.

3. Plot of the height vs. time Graph I.
4. Plot of velocity vs. time Graph II.
5. Interpretation of the two plots.

6. Answered questions.

7. One member of each group should turn in your spark tape record of
the free-fall.
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3.11. Questions

3.11 Questions

1. What is the y-intercept determined from your Graph II (or from the equation
of its best-fit line)? What does it mean?

2. Combining equation 3.4 and the equation of the best fit line from Graph II,
calculate the time at which v = 0 em/s. Explain this result.
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44

3. What is your value of the gravitational acceleration in cm/ s2 determined
from the slope from graph II7 Is this value compatible with the accepted
value of the gravitational acceleration? If not suggest a possible source of
error (NEVER just suggest “human error” or a “mistake”).

4. If the initial position and velocity were exactly zero, what would you plot
to make graph I linear: y2 vs. t, y2 vs. t2, or y vs. t27 As always, justify
your response.
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Experiment 4

Inelastic Collisions

4.1 Objectives

e Measure the momentum and kinetic energy of two objects before and
after a perfectly inelastic one-dimensional collision.

e Observe that the concept of conservation of momentum is in-
dependent of conservation of kinetic energy, that is, the total
momentum remains constant in an inelastic collisions while the kinetic
energy changes.

e Calculate the percentage of KE which will be lost (converted to other
forms of energy) in a perfectly inelastic collision between an initially
stationary mass and an initially moving mass.

4.2 Introduction

One of the most important concepts in the world of physics is the concept
of conservation. We are able to predict the behavior of a system through
the conservation of energy (energy is neither created nor destroyed). An
interesting fact is that while total energy is always conserved, kinetic energy
is not. However, momentum is always conserved in both elastic and inelastic
collisions. In this experiment and the following experiment, we will see how
momentum always remains a conserved quantity while kinetic energy does
not.
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4. INELASTIC COLLISIONS

4.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: elastic collision, and inelastic collision.

4.4 Theory

The following two experiments deal with two different types of one-dimensional
collisions. Below is a discussion of the principles and equations that will

be used in analyzing these collisions. For a single particle, momentum is

defined as the product of the mass and the velocity of the particle:

p=mu (4.1)

Momentum is a vector quantity, making its direction a necessary part
of the data. For the one-dimensional case, the momentum would have a
direction in either the +x direction or the —x direction. For a system of
more than one particle, the total momentum is the vector sum of the
individual momenta:

p=p1+p+..=mv]+mug+.. (4.2)

So you just add the momentum of each particle together. One of the
most fundamental laws of physics is that the total momentum of any
system of particles is conserved, or constant, as long as the net external
force on the system is zero. Assume we have two particles with masses
m1 and mo and velocities v and v9 which collide with each other without
any external force acting. Suppose the resulting velocities are vy p and vo s
after the collision. Conservation of momentum then states that the
total momentum before the collision (p;,itia1 = Pi) is equal to the total
momentum after the collision (pfnq = py):

pi =miuy, +mauy,  pp =iV +mova P = Df (4.3)

In a given system, the total energy is generally the sum of several
different forms of energy. Kinetic energy is the form associated with
motion, and for a single particle

'http://hyperphysics.phy-astr.gsu.edu/hbase/hph.html
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4.4. Theory

va

KE = 5 (4.4)
In contrast to momentum, kinetic energy is not a vector; for a system
of more than one particle the total kinetic energy is simply the sum of the

individual kinetic energies of each particle:

KE=KE1+ KFEy + ... (4.5)

Another fundamental law of physics is that the total energy of a system
is always conserved. However within a given system one form of energy
may be converted to another, such as in the freely-falling body lab where
potential energy was converted to kinetic energy. Therefore, kinetic energy
alone is often not conserved.

There are two basic kinds of collisions, elastic and inelastic:

In an elastic collision, two or more bodies come together, collide, and
then move apart again with no loss in kinetic energy. An example would be
two identical “superballs,” colliding and then rebounding off each other with
the same speeds they had before the collision. Given the above example
conservation of kinetic energy then implies

2

2 mivy,

mivy; mgvgi _ mlv%f
2 > 2 2

In an inelastic collision, the bodies collide and come apart again, but
some kinetic energy is lost. That is, some kinetic energy is converted to
some other form of energy. An example would be the collision between a
baseball and a bat.

If the bodies collide and stick together, the collision is called perfectly
inelastic. In this case, much of the kinetic energy is lost in the collision.
That is, much of the kinetic energy is converted to other forms of energy.

In the following two experiments you will be dealing with a perfectly
inelastic collision in which much of the kinetic energy of the objects is
lost, and with a nearly elastic collision in which kinetic energy is conserved.
Remember, in both of these collisions total momentum should always be
conserved.

Since we are considering inelastic collisions today, let’s consider what
the kinetic energy should be in the initial and final states. If we look at
Eq. 4.4, we can see that the initial kinetic energy is

KEipitial = KEfz'nal (4‘6>
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4. INELASTIC COLLISIONS

2 2 2
mlvlz m21}2z m]_vll

KE; = = 4.
it 5 (4.7)

because Cart 2 is initially at rest (vo, = 0).
The final kinetic energy is defined as

(m1 +ma)v}
2
because the two carts have stuck together after the collision (vy = vy =
v, is the common velocity of the two carts).

Using the conservation of momentum, we can calculate the final momen-
tum as

KEj = (4.8)

myvy, + mavy, = mivy, = (m1 +ma)vy (4.9)

Using Eqgs. 4.7, 4.8, and 4.9, we arrive at the equation for K E¢ in terms
of KEZ'.

KEjf = (mlﬂlﬁg)) KE; (4.10)

This is the prediction for the final kinetic energy of a perfectly
inelastic collision.

4.5 In today’s lab

Today you will get to see how inelastic collisions work while you vary the
masses on two colliding carts. You will then see how there is a significant
energy loss in these types of collisions and will try to figure out where this
energy goes.

4.6 Equipment

e Air Track

e Air Supply
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4.7. Procedure

Figure 4.1: Equipment used in lab fully set up.

Two carts one with needle and one with clay (carts are sometimes
called gliders)

Photogate Circuit

4 - 50g masses

4.7 Procedure

Do not move the carts on the air track when the air is not turned
on. It will scratch the track and ruin the “frictionless” environ-
ment we need to get accurate data.

1.

Start by making sure that the air track is level. Your instructor will
demonstrate how at the beginning of class.

Set up the photogates such that there is sufficient room for the collision
to happen in the middle and enough room on the remainder of the
track for the carts to move freely.

Set the photogates to GATE mode.

We will define Cart 1 as the cart with the fin and Cart 2 as the cart
without. We will always push Cart 1 for each trial and will always
start with Cart 2 stationary (vo, = Ocm/s) in the middle. Before
placing the carts on the track, measure the mass of them without the
extra masses. Record the empty cart masses data on the given results
sheet.
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D.

10.

11.

12.

13.

14.

20

Measure the length of the fin on Cart 1 and record this on your results
sheet and in excel. Be sure to put a reasonable uncertainty for the fin
length in excel as well.

Input the uncertainty for the times measured by the photogate into
excel (0.0005 s).

Put all four 50g masses on Cart 2 such that it is evenly distributed (2
masses on each side).

Place Cart 2 in between the photogates and have one partner hold it
steady up until the collision takes place.

Place Cart 1 “outside” of the photogates.

Making sure that your photogates are reset, give a brief but firm shove
to Cart 1 such that it collides and sticks together with Cart 2. Allow
the two carts to leave the middle completely before stopping them.
Do not allow the carts to pass through the photogates again
until you finish recording their times.

Record the time for Cart 1 to pass through the first photogate (¢;) in
excel, then press the READ switch and record (tmem) as well.

Calculate the time for the combined cart system to pass through the
second photogate using the formula ¢ f=lmem — 1 and input that into
your notebook and excel file.

Note that the initial velocity of Cart 1 (vy,) is calculated using the
formula L/t; and that the final velocity of the combined cart system
is calculated using the formula L/t

Make sure that the absolute value of the percent difference between
initial and final momentum is less than 5% (the spreadsheet does this
calculation for you). If it is not, rerun the trial until it is. Compress
the putty in the counterbalance in between trials. Also make sure that
the fin on top of Cart 1 is completely through the photogate before
the collision occurs. If the trial is acceptable, record the times on your
worksheet. Always try to keep your best trial written down on your
worksheet, even if it does not fit our desired percent difference.
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4.8. Uncertainties

15. Repeat this trial one more time and record the results.
16. Repeat steps 6-15 for the cases when you have:

e 2 mass disks on Cart 1 and 2 mass disks on Cart 2

e 2 mass disks on Cart 1 and no mass disks on Cart 2

17. Be sure to include hand calculations for the light blue boxes in excel.

4.8 Uncertainties
In today’s experiment we have already input all of the equations into excel

for you out of the interest of brevity, but it is important to understand the
uncertainties for the values you used in this experiment. The uncertainty

for velocity is:
ov="uv oL + ot
-\ L ¢t

The uncertainty for momentum is:

0P = P5—U

v
And the uncertainty for kinetic energy is:
IKE =2K Eé_v
v

The uncertainties for the differences for the momenta and kinetic energies
are then:

5Pdiff = 5Pf + 5P@' and (SKEdiﬁ“ = 5KEf + 5KEZ'

4.9 Checklist

1. Excel sheets
2. Questions

3. Hand Calculations
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4.10. Questions

4.10 Questions

1. For which of your trials was momentum conserved? The scientific way to
address this question is to ask, for which of your trials is Pg;g compatible
with zero? Also, if momentum is not conserved for any of your trials, suggest
a possible source of error.

2. Was kinetic energy conserved for any of your trials? If not, how much kinetic
energy was lost?
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o4

3. Compare one of your measured K Ey trials with the K Ey .. prediction of
equation 4.10 for a perfectly inelastic collision. Use your measured masses
and K E; value. Are they compatible? The uncertainty of KEy .4 Is:

IKE;
IKFE =KFE —Z>
( f cale f calc KE;

4. Combine equations 4.7, 4.8 and 4.9 to obtain the expression in equation 4.10.
Hint: solve equation 4.9 for v f» then substitute this into equation 4.8.
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Experiment 5]

Elastic Collisions

5.1 Objectives

e Measure the momentum and kinetic energy of two objects before and
after a one-dimensional collision.

e Try to account for any change in KE in the nearly elastic collision.

e Compare and contrast the results obtained from the inelastic collision
experiment with the results obtained from this experiment.

5.2 Introduction

Now that we are acquainted with inelastic collisions, it is time to investigate
elastic collisions. This time around, we will observe the conservation of both
momentum and kinetic energy. Energy can tell us a great deal about how a
system works, and if it is conserved, we can understand the process much
better than if we cannot. Though we are not in the ideal and impossible
conditions of a perfectly frictionless system and in vacuum, we will be able
to see these conservation laws with very good precision.
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5.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: elastic collision.

5.4 Theory

Please refer to the inelastic collision lab to refresh your knowledge of the
theory for collisions.

5.5 In today’s lab

In today’s lab, we will observe the effects on changing the mass in elastic
collisions between two carts. After collecting our data, we will then compare
the results of elastic collisions with those of inelastic collisions and try to
understand where energy loss can occur.

5.6 Equipment

o Air Track

Air Supply

Two carts (one with bumper and one with blade, see Fig. 5.1)

Photogate Circuit

4 50g masses

http://hyperphysics.phy-astr.gsu.edu/hbase/hph.html
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Figure 5.1: Cart with bumper.

5.7 Procedure

1. Start by making sure that the air track is level. Your instructor will
demonstrate how at the beginning of class.

2. Set up the photogates such that there is sufficient room to reset the
timer before the collision, for the collision to happen in between the
photogates, and enough room on the remainder of the track for the
carts to move freely.

3. Set the photogates to GATE mode.

4. We will define Cart 1 as the cart with the bumper and Cart 2 as the
cart with the bumper blade. We will always push Cart 1 for each trial
and will always start with Cart 2 stationary (vg, = Ocm/s) in the
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10.

11.

12.

13.

o8

middle. Before placing the carts on the track, measure their mass
without the extra masses. Record the empty cart masses data on the
given results sheet.

Measure the lengths of the fins on both carts and record them on your
worksheet and in excel. Be sure to put a reasonable uncertainty for
the fin length in excel as well.

Input the uncertainty for the times measured by the photogate into
excel (0.0005 s).

Put 2 masses on Cart 2 so they are evenly distributed (1 on each side)
and no masses on Cart 1.

Place Cart 2 in between the photogates and have one partner hold the
cart steady until the collision occurs.

Place Cart 1 “outside” of the photogates.

Making sure that your photogates are reset, give a brief but firm shove
to Cart 1 such that it collides with Cart 2. Allow the two carts to leave
the middle completely before stopping them. Do not let the carts
drift back through the photogates until you finish recording
the times. Be sure to have one partner memorize the first time that
appears on the photogate (¢;) and reset the photogate before either
cart passes through the photogates following the collision. It
may take multiple tries to get this method correct, so feel free to
practice a few times.

Record t; and in Excel. Also record the other times off of the photogate
in Excel. If you reset the timer at the correct moment, the
time you read on the photogate prior to flipping the READ
switch will be either ¢; ; or ta, depending on which cart left
the middle first. The other time will be calculated the same
way as before using t,em-

Once again, note that the velocities for each cart are calculated in the
same way as before (i.e. L/t).

Make sure that the absolute value of the percent difference between
initial and final momentum is less than 5% and the absolute value of
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5.8. Checklist

the percent difference between initial and final kinetic energy is less
than 10% (the spreadsheet does these calculations for you). If they
are not, rerun the trial until they are. Make sure that the fin on top of
Cart 1 is completely through the photogate before the collision occurs
and that the carts remain outside of the photogates until you have
your times recorded. If the trial is acceptable, record the times on your
worksheet. Always keep your best trials recorded on the worksheet
just in case you run out of time and need to use those.

14. Repeat this trial one more time and record the results.
15. Repeat steps 8-14 for the cases when you have:

e 2 mass disks on Cart 1 and 2 mass disks on Cart 2

e 2 mass disks on Cart 1 and no mass disks on Cart 2

For trials 3 and 4, you can use 1000s for ¢1, as in an ideal case, Cart 1
will transfer all of its momentum to Cart 2 and will stop moving after
the collision.

16. Be sure to include hand calculations for the light blue boxes in excel.

5.8 Checklist

1. Excel Sheets
2. Questions

3. Hand Calculations
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5.9. Questions

5.9 Questions

1. For which of your trials was momentum conserved? Justify your response.
Also, if momentum is not conserved for any of your trials, suggest a possible
source of error.

2. For which of your runs was kinetic energy conserved? Justify your response.
Also, if energy is not conserved for any of your trials, suggest a possible
source of error.
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3. Momentum was supposed to be approximately conserved in both the inelastic
and elastic collision experiments. Compare the percent change in kinetic
energy for the inelastic collisions experiment with the elastic collisions
experiment.

4. Where did the kinetic energy go that was lost in the inelastic collisions you
performed in the previous experiment?
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Experiment )

Heat Equivalent of Mechanical
Energy

6.1 Objectives

e Observe the conversion of mechanical energy into heat.

e Learn how to convert the units traditionally used to measure heat
(calories) into the units appropriate to mechanical energy (joules).

6.2 Introduction

In the previous labs, we have been using friction as a reason for energy loss,
but how does that happen? When you have friction on an object, the object
begins to heat up. You can try this by simply rubbing your hands together
really quickly. You can feel your hands heat up due to the motion you are
imparting by rubbing them together! The exact same thing happens with
everything else in nature. Whenever something is in contact with something
else and they are moving relative to each other, the friction between the two
objects will heat them up, and without any external forces, the objects will
lose energy.
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6. HEAT EQUIVALENT OF MECHANICAL ENERGY

6.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: heat, specific heat, heat transfer

6.4 Theory

In your physics course on mechanics, you saw the Law of Conservation
of Mechanical Energy expressed this way:

Work Done on a System = APE + AKE (6.1)

where KE is kinetic energy and PE is potential energy. If there are
frictional forces present, we can divide up the total work done on the system
into the work done by external forces and the work done by friction:

External Work + Friction Work = APE + AKE (6.2)

Remember that Friction Work is negative, because the frictional force
on a moving object always points in the direction opposite to the direction
of motion.

There is another way to think about friction. Instead of treating the
friction as an external force that does work on the system, we can expand
our definition of the system to include the source of friction. (For example,
if our original system were a block sliding across the floor, our new system
would be the block and the floor together.) Then we have to recognize
that the energy in the system may be converted from mechanical energy
into other forms of energy, such as heat or thermal energy. From this more
general point of view, the Law of Conservation of Energy takes this
form:

External Work = APE + AKE + A(Thermal Energy) (6.3)
Comparing Egs. 6.2 and 6.3 leads us to the conclusion that

— Friction Work = A(Thermal Energy) (6.4)

Remember that Friction Work is negative, so both sides of this equation
are positive. Equation 6.4 says that the loss in mechanical energy due to

http://hyperphysics.phy-astr.gsu.edu/hbase/hph.html
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6.4. Theory

Figure 6.1: Schematic of the apparatus.

friction equals the gain in thermal energy of the system. Equation 6.4 is the
relation you will test in this Lab.

A nylon rope (a) is wrapped around an aluminum drum (b) and is held
by hand at one end. At the other end of the band dangles a 5 kg mass (m).
The aluminum drum is turned beneath the rope by means of a crank (c)
turned by a student, and the 5 kg mass remains stationary. As the drum
turns it rubs against the band, and the resulting friction generates heat,
which causes the temperature of the band and of the drum to rise. The rise
in temperature is a measure of the heat energy generated. To test equation
6.4 we must calculate the friction work, measure the change in heat
energy, and see whether they are equal. We will now discuss how this can
be done.

You may be wondering, “Where did the thermal energy come from?”
It didn’t just appear magically. Going back to Equation 6.2 or 6.3, you
can see that it comes from the external work that you do by turning the
crank. In fact, in this experiment the block starts and ends in the same
place, so APE = AKE = 0, and the work you do should be exactly equal
to the increase in thermal energy. But it is hard to measure the work you
do. It is much easier to measure the work done by friction, as we show below.
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Figure 6.2: Diagram of f; and S||-

Work Done by Friction

Friction work is given by the equation
Friction Work = —fs (6.5)

where [y is the force of friction, and | is the distance parallel to fy over
which the force of friction acts. The work done by friction is negative because
[ always points in the direction opposite to the direction of motion of the
body. To see what f; and S| are, we refer to Fig. 6.2.

We see in Figure 6.2 that the 5 kg mass is being pulled down by gravity
with a force mg, with m = 5 kg. Since the mass isn’t accelerating, the rope
must be pulling up on it with the same force. So the tension in the vertical
part of the rope is equal to mg. The other end of the rope, however, is
slack. How did that happen? The frictional force between the drum and
the rope must exactly equal mg, because that is the difference in tension
of the vertical and horizontal sections of the rope. That frictional force is
distributed along the whole length of the rope that is wrapped around the
drum 4 or 5 times. The distance 5| is the total distance the outer edge of
the drum moves against the rope. That is equal to the circumference of
the drum, cp, times the number of times the crank is turned, n. So
we have S| = ncp. Putting all this together, we get:

Friction Work = —(mg)(ncp) (6.6)
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Change in Heat Energy

When heat is added to a system, it causes the temperature of the system
to rise. The heat energy added, AH, is related to the temperature rise, AT,
by the equation:

AH = CM(AT) (6.7)

where C' is the specific heat capacity of the system and M is the mass of
the system. To calculate AH you need to know C' and you need to measure
M and AT.

Although heat is just another form of energy, and can therefore be
measured in Joules, for historical reasons it is measured in terms of different
units, called calories. One calorie is defined as the amount of heat needed
to raise the temperature of one gram of water by one degree Celsius. The
conversion factor between calories and joules is:

1 calorie = 4.18 joules (6.8)

In the present experiment, C' is made up of contributions from two
different components, the aluminum drum and the nylon rope. We will
neglect the heating of the rope. The heat capacity is given by the product
of the mass of the component times the specific heat capacity of the material
of which the component is composed. Water has a specific heat capacity of
1 cal/g° C and aluminum has a specific heat capacity of 0.215 cal/g® C. The
contribution of the drum is (0.215 cal/g® C) Mp where Mp is the mass of
the drum. The nylon band has negligible heat capacity. With these values,
equation 6.6 takes the form:

AH (in calories) = [0.215M p|AT (6.9)

If all the mechanical work goes into heat, then using equation 6.8,

AW = 4.18AH (6.10)

This is the relationship we will test in this experiment.
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6.5 In today’s lab

Today we will cool down an aluminium drum to 3° C below room temperature.
We will then attempt to use friction to heat the drum to 3° above room
temperature using a calculated number of cranks. Finally, we will see if our
calculation was correct using a consistency check.

6.6 Equipment

e Aluminum Drum

Nylon Rope

Thermocouple

5 kg Hanging Mass
Crank

Calipers

6.7 Procedure

1. Determine the mass of the aluminium drum and record it in your
spreadsheet.

2. Using the thermocouple, determine the room temperature by inserting
the probe into the heat measurement hole of the drum. Do this by
setting the thermocouple to mV and by pressing the yellow button to
set it to Celcius. Record this in your spreadsheet.

3. Measure the circumference, c¢p, of the aluminium drum using the
vernier calipers. Record this in your spreadsheet.

4. To compensate for heat loss during the experiment, we will cool the
drum in the refrigerator. Carefully remove the aluminium drum from
the crank and place it in the refrigerator until it is at least 3° C below
room temperature.
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5. While the drum is cooling, calculate the number of cranks needed to
raise the drum’s temperature by 6° C using equation 6.6.

6. When the drum is sufficiently cooled, place it back onto your crank
and be sure to lock it down securely, making sure that the pin on the
crank lines up with the slot on the cylinder.

7. Wrap the nylon string around the drum 4 or 5 times, and have one
partner elevate the 5 kg weight off approximately 2-3 inches off of the
ground. Be sure that they hold on to the loose end of the string to
help support the weight. Please make sure your feet are not under the
5 kg mass.

8. When the drum is exactly 3° C below room temperature, begin crank-
ing the crank the designated number of times that you calculated. Be
sure to crank fast enough that the drum remains suspended in the
air without additional force. The partner holding the loose end of the
string can easily adjust the height of the mass while the crank is being
turned by pulling on or loosening the string.

9. After cranking the designated number of times, measure the final
temperature of the drum and record it in excel.

10. Calculate AW (the Friction Work) and AH (the change in Heat
Energy in calories). Use Eq. 6.10 to convert from calories to Joules.
Compare the change in Heat Energy to the work done (the formulae
for the uncertainties are in the excel spreadsheet for this lab).

6.8 Checklist

1. Excel Sheets
2. Sample Calculations

3. Questions

Last updated May 8, 201/ 69






6.9. Questions

6.9 Questions

1. Was energy conserved through the conversion of mechanical to thermal
energy (justify your response)? If not, suggest a possible source of error.

2. Assume you repeat the experiment and turn the crank twice as fast. Also
assume the hanging mass remains suspended above the floor and stationary
while you repeat the experiment. Would it make a difference in your result
because you turned the crank more rapidly? Why or why not?
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3. The available energy contents of various kinds of food are often listed in
“Calories” charts. One of these food “Calories” is actually 1000 calories
of the type defined in this experiment, i.e. 1 food Calorie = 1 kcal or
kilocalorie. Assuming the human body is 50% efficient in the conversion of
food Calories into mechanical work, how many turns of the crank would
have been necessary to work off an average breakfast of about 600 food
Calories? An efficiency of 50% means that only 50% of the food energy
intake can be used for mechanical work. The other 50% is wasted in the
form of heat (sweating).
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Experiment 7

Rotational Motion: Moment of
Inertia

7.1 Objectives

e Familiarize yourself with the concept of moment of inertia, I, which
plays the same role in the description of the rotation of a rigid body
as mass plays in the description of linear motion.

e Investigate how changing the moment of inertia of a body affects its
rotational motion.

7.2 Introduction

In physics, we encounter various types of motion, primarily linear or rota-
tional. We have already learned how linear motion works and the relevant
quantities we need to look at in order to understand it. Today we will inves-
tigate rotational motion and measure one of the most important quantities
pertaining to that: the moment of inertia. The way mass is distributed
greatly affects how easily an object can rotate. For example, if you are
sitting in an office chair and start spinning around, you can notice that
if you extend your arms away from your body, you will begin to rotate
slower than when you started. If you then pull your arms back in as close as
possible, you will start to rotate much faster than you just were with your
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arms extended. This gives us evidence of the reliance that the moment of
inertia has on mass and how it is distributed.

7.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: moment of inertia, torque, angular acceleration

7.4 Theory

If we apply a single unbalanced force, F', to an object, the object will undergo
a linear acceleration, a, which is determined by the unbalanced force acting
on the object and the mass of the object. The mass is a measure of an
object’s inertia, or its resistance to being accelerated. Newton’s Second Law
expresses this relationship:

F=ma

If we consider rotational motion, we find that a single unbalanced torque
7 = (Force)(lever arm)

produces an angular acceleration, o, which depends not only on the mass
of the object but on how that mass is distributed”. The equation which is
analogous to F' = ma for an object that is rotationally accelerating is

7=l (7.1)

where the Greek letter tau (7) represents the torque in Newton-meters,
o is the angular acceleration in radians/sec?, and I is the moment of
inertia in kg-m2. The moment of inertia is a measure of the way the
mass is distributed on the object and determines its resistance to angular
acceleration.

Every rigid object has a definite moment of inertia about any particular
axis of rotation. Here are a couple of examples of the expression for I for
two special objects:

http://hyperphysics.phy-astr.gsu.edu/hbase/hph.html

2In this lab the lever arm will be the radius at which the force is applied (the radius of
the axle). This is due to the fact that the forces will be applied tangentially, i.e., perpendic-
ular to the radius. The general form of this relationship is 7 = (force)(lever arm)(sin(6))
where 6 is the angle between the force and the lever arm. However, in this experiment 6
is 90° and sin(90°) = 1.)
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7.4. Theory

Figure 7.2: Two point masses on a weightless rod (I = mlr% + m2r2).

To illustrate, we will calculate the moment of inertia for a mass of 2 kg
at the end of a massless rod that is 2 m in length (Fig. 7.1 above):

I =mr? = (2kg)(2 m)? = 8 kg m?

If a force of 5 N were applied to the mass perpendicular to the rod (to
make the lever arm equal to r) the torque is given by:

T=Fr=(BN)(2m)=10Nm
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By equation 7.1 we can now calculate the angular acceleration:

Note: The moment of inertia of a complicated object is found by adding
up the moments of each individual piece (Figure 7.2 above is the sum of two
Figure 7.1 components).

7.5 In today’s lab

Today we will measure the moment of inertia for multiple mass distributions.
We will plot our data and determine the relationship of the moment of
inertia and the radii that our masses were placed at.

7.6 Equipment

2 Cylindrical Masses

Hanger

Small Masses

Main Axle

e String

In our case, the rigid body consists of two cylinders, which are placed
on a metallic rod at varying radii from the axis of rotation. The cylinders
and rod are supported by a rotating platform attached to a central pulley
and nearly frictionless air bearings. A side view of the apparatus is shown
in Figure 7.3 and a top view of the central pulley is shown in Figure 7.4.

In this experiment, we will change the moment of inertia of the rotating
body by changing how the mass is distributed on the rotating body. We will
place the two cylindrical masses at four different radii such that r =r; = r9
in each of the four cases. We will then use our measurements to calculate the
moment of inertia (I) for each of the four radial positions of the cylindrical
masses (7). The sum of the two cylindrical masses (mj + mg) can then be

found from a graph of I versus r2.
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7.6. Equipment

Side pulley with

air bearing
_\\’ central pulley
) radius = R
. 4———— Air bearing
4—— Stationary base
T=Mg-Ma
W=Mg J/ T = string tension

Figure 7.3: Moment of Intertia Apparatus

string

Figure 7.4: Central Pulley (axle)

To set up your rigid body, wrap the string around the central pulley
(axle) and run it over the side pulley to a known weight as shown in Figure
7.3.

Consider the following steps:

If we release the weight from rest, the tension in the string will exert
a torque on the rigid body causing it to rotate with a constant angular
acceleration a. The angular acceleration of the rigid body is related to the
linear acceleration of the falling mass by:

- Linear acceleration  a

Radius of axle R
Last updated May 8, 2014 7
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or

a = Ra (7.2)

From Figure 7.3 and Newton’s Second Law, the tension in the string is:
T=Mg— Ma (7.3)

The tension in the string causes a net torque on the rigid body. Since
Torque = (Lever arm) (Force), the net torque on the rigid body is given by:

T=RxT (7.4)

The moment of inertia of the rigid body is then found from equation 7.1
(1 =1a).

7.7 Procedure

1. Measure and record the masses of the hanging mass (M) and the two
cylinders (m1 and mo).

2. Place the cylinders on the horizontal rod such that the axes of the
cylinders are along the horizontal rod (as shown in Figure 7.5). Make
sure the thumbscrew on each cylinder is tightened. The center of
mass of each cylinder must be the same distance (1) from the axis of
rotation (i.e. r1 = rg in Figure 7.3). Estimate the uncertainty in r
(called dr). This should include both the uncertainty in reading your
ruler and the uncertainty in locating the cylinder’s center of mass.

3. With the air supply on, attach the hanging mass (M) to one end of a
string and wind the other end around the central pulley. The string
should also pass over the side pulley such that the hanging mass is just
below the side pulley. Hold the hanging mass stationary and measure
its elevation (y) using the floor as your reference level. Record this
elevation in your spreadsheet and assign an appropriate uncertainty to
this measurement. Then release the hanging mass and simultaneously
start the desktop timer. When the mass hits the floor, stop the timer.
For the uncertainty in this time (6¢), use the standard deviation of a
measurement (denoted by s) from the Reaction Time experiment.
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Figure 7.5: View of main axle with 2 masses at same radius r

. The position, y, of an object released from rest a distance h above the

floor is found using: y = h — %~. The final position of the mass is
= 0, so the acceleration is found using: a = %é‘

Calculate the linear acceleration of the falling mass (M) and use
da =a (25t + %h) to calculate its uncertainty.

. Use equation 7.3 to calculate the tension in the string (7') and use
or =T <5WM 5a ) to calculate its uncertainty.

. Use R =1.2740.01 cm for the radius of the central pulley and equation
7.2 to calculate the angular acceleration of the rotating apparatus. In

addition, use da = « <5a + 5]§> to calculate its uncertainty.

. Use equation 7.4 to calculate the unbalanced torque on the rotating
apparatus and use 07 = T (5T + 5R) to calculate the uncertainty in

this torque. (Note: in this equation the Greek letter 7 (tau) is the
torque and T is the tension in the string.)

. Use equation 7.1 to calculate the moment of inertia of the rotating
apparatus; the uncertainty in moment of inertia is given by:

ol =1 <67T + %). Calculate r2 and its uncertainty, 6r2 = 2r-dr.
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9.

10.

Repeat steps 2-8 for two additional (non-zero) values of r. Make sure
that these values differ by at least 2 cm.

We would like to place the two cylinders at » = 0. To do this, we will
use the vertical bar on the support (see Figure 7.6). When you place
the cylinders on the vertical bar, make sure they are oriented the same
way as in your previous trials, i.e. with the axes of the two cylinders
perpendicular to the vertical bar. As before, make sure to tighten the
thumbscrews on the cylinders. Follow the procedure in steps 3-8 to
calculate the moment of inertia of the body with the two cylinders at
r = 0. Include this data in your data table.

Figure 7.6: View of main axle with 2 masses at radius r = 0

11. Transfer your data into KaleidaGraph and make a plot of I vs. r2.

30

Your data points should have both horizontal and vertical error bars.
Also, fit your data with a best fit line, display its equation with the
uncertainties in the slope and intercept. When the two cylinders are
placed on the axis of rotation, the measured moment of inertia I is
the moment of inertia of the rotating apparatus alone plus the moment
of inertia of each of the two cylinders about an axis through their own
centers of mass.

I=1I (7.5)
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7.8. Checklist

If the two masses are now each placed a distance r from the axis of
rotation then equation 7.5 becomes:

I = (mq +mao)r? + I (7.6)

If you compare equation 7.6 to the form of an equation for a straight
line:
y=mx+b

You can see that a plot of I vs. rZ should be a straight line. The slope
of this line is the sum of the masses (m1 4+ mg) and the intercept is Ij.

7.8 Checklist

1. Excel Sheets
2. Plot of I vs. 2 with proper error bars and fit line.

3. Questions
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7.9. Questions

7.9 Questions

1. The moment of inertia of a body depends not only on its mass, but also on
how the mass is distributed. Does your data support this? Why or why
not?

2. Discuss the consistency of the slope of the plot of I vs. r2 with the value
you measured for (mqj 4+ msg). If they are not consistent, suggest possible
sources of error.
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3. In your plot of I vs. 72, why did you use r2 and not = in the plot? What
are the units of the slope of I vs. r2?

4. In step 6 of the procedure, you were given that R = 1.27 + 0.01 cm. Using
only the experimental apparatus and a meter stick, how would you verify
this radius with an uncertainty of less than or equal to 0.01 cm?

(Hint: You cannot get this uncertainty by holding the meter stick next to
the axle and measuring the diameter. Also note that the string is a part of
the apparatus.)
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Experiment S

The Pendulum

8.1 Objectives

e Investigate the functional dependence of the period (7) of a pendulum
on its length (L), the mass of its bob (m), and the starting angle (6).
The Greek letter tau (7) is typically used to denote a time period or
time interval.

e Use a pendulum to measure g, the acceleration due to gravity.

8.2 Introduction

Everyday we experience things moving in a periodic manner. For example,
when you go to a park, you can see children playing on a swingset. As they
move back and forth, they are undergoing periodic motion, much like that of
a pendulum. Pendula are great tools for measuring time intervals accurately,
but they also can be used to measure gravity if you know how. Today, we
will investigate how a pendulum works, what affects it period, and try to
measure gravity (once again) using what we know in physics.

8.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: angular acceleration, pendulum

http://hyperphysics.phy-astr.gsu.edu/hbase/hph.html
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8. THE PENDULUM
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Figure 8.1: Force diagram of a pendulum

8.4 Theory

In the analysis of the motion of a pendulum we should realize that

1. The motion is part of a circle so angular acceleration («) is a useful
variable

2. The angular acceleration will not be a constant throughout the motion

Consider the pendulum shown in Figure 8.1. The weight at the end of the
string is called the “bob” of the pendulum. The acceleration, a¢, of the bob
tangent to the arc “drawn” by the pendulum as it swings is determined
by F}, the force tangent to the arc. Since the tension in the string (7)
always acts along the radius, it does not contribute to F;. Decomposing
the gravitational force mg into components perpendicular and parallel to
the string as shown in Figure 8.1, we find that

Fy = mgsinf

86 Last updated May 8, 201/



8.5. In today’s lab

Therefore, the acceleration tangent to the circle is given by:
t .
ay = — = gsinf
m

The angular acceleration « is then found by the relationship for circular
motion
a=-2 = Igng
r L
Thus, as we have suggested, the angular acceleration « is not a constant
but varies as the sine of the displacement angle of the pendulum.
For small angles (about 6 < 0.5 radians), angular accelerations can be

shown (with a little calculus which we will skip) to lead to an oscillation of

the angle 6 by
27t
0 = Bycos (i)
-

where 6 is the angle at time ¢ = 0 (when we release the pendulum), and 7
is the period of the motion. The period is the time it takes to complete one
full cycle of the motion.

The period (7) of a pendulum depends only on its length (L) and the
acceleration due to gravity (g). The period (1) is independent of the mass of
the bob (m) and the starting angle (6y). The period of a simple pendulum
is given by:

L 2
T=2my/— or 7':—7r L

g V9

This equation has the same form as the equation of a straight line,
y = mx + b, with an intercept of zero (i.e. b = 0). Notice in this equation,
the period (7) corresponds to y and VL corresponds to z.

8.5 In today’s lab

Today we will change various parameters of the pendulum and see how they
affect its period. We will change the

1. Mass
2. Starting angle
3. Length
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THE PENDULUM

of the pendulum independently of each other and measure the period. We
will then plot our results and see if we can accurately measure gravity using
a pendulum.

8.6 Equipment

Masses
String
Photogate
Compass

Meter Stick

8.7 Procedure

38

1.

Measure the masses of the point masses provided. Use the six heaviest
masses in order to get the most accurate data.

Measure the length, Ly you will use for the trials where you vary the
mass m and starting angle 6y of the pendulum and record it in the
appropriate cells in your excel sheet.

Put the photogate on the PEND setting.

Set a starting angle such that 6y = 15° from vertical and record it in
your data sheet.

Place a mass on the end of your pendulum and record it in your data
sheet.

Move the pendulum to that angle and release it, allowing it to complete
one full oscillation. Record the time shown on the photogate in your
data sheet. This is your period 7.

Repeat steps 5 and 6 five more times using different masses each time.
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8. Now choose one of the masses you've just used as the mass to use
for the starting angle and length trials, hang it on the end of the
pendulum, and record the mass in the appropriate cells in your data
sheet.

9. Keeping the same string length, record 6 periods for trials where you
vary your starting angle 6. Here you can choose any starting angle
as long as fy remains less than 30° from the vertical. Make sure that
each starting angle is at least 4° different from any other starting angle
you used. Also, one of your trials should be 6y = 15°.

10. Keeping the same mass on the end of the string and starting your
pendulum at the same starting angle 6y you chose in step 4, measure
the period for 6 trials where you change the length of the pendulum
and record it in your data sheet. Make sure that there is at least a
5 cm difference between the lengths you choose to use. One of the
lengths used should be the one used in steps 7 and 9.

11. Using the correct formula and the “fill down” method in Excel, calcu-
late v/L in your data sheet.

12. Create plots for
e Period (7) vs. m (for fixed 6y and L)
e Period (7) vs. 0y (for fixed m and L)
e Period (7) vs. VL (for fixed m and 6;)

e You do not need a formula view for this experiment

in KaleidaGraph. Use the same scale for the axis displaying period
7. You can determine this scale by selecting the smallest and largest
values out of all of your trials and using those as your minimum and
maximum values respectively for your axis limits. Be sure to fit each
plot with a best fit line.

8.8 Checklist

1. Excel Sheets

2. Plot for Period (7) vs. m
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8. THE PENDULUM

3. Plot for Period (7) vs. 6
4. Plot for Period (7) vs. VL

5. Questions
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8.9 Questions

a) Comment on how the period depends on each of the three parameters
(m, 0, and V/L). The period is independent of a parameter if the slope
of your best fit line is consistent with zero.

b) By what percent does the period vary with each parameter. Use
7(Lg, 15°) as your reference?
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8. THE PENDULUM

2. Use the slope of the graph of 7 vs. v/L to calculate g and its uncertainty.

3. Is your value of g consistent with 981 cm/ sec2? If not, suggest a possible
source of error.
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Experiment 9

The Spring: Hooke’s Law and
Oscillations

9.1 Objectives

e Investigate how a spring behaves when it is stretched under the influ-
ence of an external force. To verify that this behavior is accurately
described by Hooke’s Law.

e Measure the spring constant (k) in two independent ways.

9.2 Introduction

Springs appear to be very simple tools we use everyday for multiple purposes.
We have springs in our cars to make the ride less bumpy. We have springs
in our pens to help keep our pockets/backpacks ink free. It turns out that
there is a lot of physics involved in this simple tool. Springs can be used
as harmonic oscillators and also as tools for applying a force to something.
Today we will learn about the physics involved in a spring, and why the
spring is such an interesting creation.
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9. THE SPRING: HOOKE’S LAW AND OSCILLATIONS

9.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: Hooke’s Law, oscillation

9.4 Theory

Hooke’s Law

An ideal spring is remarkable in the sense that it is a system where the
generated force is linearly dependent on how far it is stretched. Hooke’s
law describes this behavior, and we would like to verify this in lab today. In
order to extend a spring by an amount Az from its previous position, one
needs a force I’ which is determined by F' = kAx. Hooke’s Law states that:

Fg¢ = —kAx (9.1)

Here k is the spring constant, which is a quality particular to each
spring, and Az is the distance the spring is stretched or compressed. The
force Fg is a restorative force and its direction is opposite to the direction
of the spring’s displacement Ax.

To verify Hooke’s Law, we must show that the spring force Fig and the
distance the spring is stretched Az are proportional to each other (that
just means linearly dependant on each other), and that the constant of
proportionality is —k.

In our case the external force is provided by attaching a mass (m) to
the end of the spring. The mass will of course be acted upon by gravity,
so the force exerted downward on the spring will be Fj; = mg (see Figure
9.1). Consider the forces exerted on the attached mass. The force of gravity
(mg) is pointing downward. The force exerted by the spring (—kAz) is
pulling upwards. When the mass is attached to the spring, the spring will
stretch until it reaches the point where the two forces are equal but pointing
in opposite directions:

Fg—F;=0o0rmg=—kAzx (9.2)

This point where the forces balance each other out is known as the
equilibrium point. The spring + mass system can stay at the equilibrium

lhttp://hyperphysics.phy-astr.gsu.edu/hbase/hph.html

94 Last updated May 8, 201/


http://hyperphysics.phy-astr.gsu.edu/hbase/hph.html
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Figure 9.1: Force diagram of a spring in gravity.

point indefinitely as long as no additional external forces come to be exerted
on it. The relationship in Eq. 9.2 allows us to determine the spring constant
k when m, g, and Ax are known or can be measured. This is one way in
which we will determine k£ today.
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9. THE SPRING: HOOKE’S LAW AND OSCILLATIONS

Oscillation

The position where the mass is at rest is called the equilibrium position
(x = x(). As we now know, the downward force due to gravity F; = mg and
the force due to the spring pulling upward Fg = —kAxz cancel each other.
This is shown in the first part of Figure 9.2. However, if the string is stretched
beyond its equilibrium point by pulling it down and then releasing it, the
mass will accelerate upward (a > 0), because the force due to the spring
is larger than gravity pulling down. The mass will then pass through the
equilibrium point and continue to move upward. Once above the equilibrium
position, the motion will slow because the net force acting on the mass is
now downward (i.e. the downward force due to gravity is constant while
the upwardly directed spring force is getting smaller). The mass and spring
will stop and then its downward acceleration will cause it to move back
down again. The result of this is that the mass will oscillate around the
equilibrium position. These steps and the forces (F'), accelerations (a), and
velocities (v) are illustrated in Figure 9.2 for the first complete cycle of
an oscillation. The oscillation will proceed with a characteristic period, 7,
which is determined by the spring constant and the total attached mass.
This period is the time it takes for the spring to complete one oscillation, or
the time necessary to return to the point where the cycle starts repeating
(the points where x, v, and a are the same). One complete cycle is shown in
Figure 9.2 and the time of each position is indicated in terms of the period

7, where
fm
=24 [ — 9.3
T T ? (9.3)

By measuring the period for given masses the spring constant can be
determined. This is the second way we will determine k& today. You will use
this value of k to verify that the proportionality constant you determined
for Hooke’s Law in the first part is indeed the correct &k for the spring.
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Figure 9.2: Oscillation of a spring.

9.5 In today’s lab

Today we will measure the spring constant of a given spring in two ways.
First we will add mass gradually to the spring and measure the displacement,
then plot the results to find the spring constant. Then, we will find the
period of oscillation for the spring after attaching varying mass to the

bottom. Once again, we will plot these results to find the spring constant a
different way.

9.6 Equipment

e Spring

Photogate

Masses

Hanger
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THE SPRING: HOOKE’S LAW AND OSCILLATIONS

9.

7 Procedure

Part I: Hooke’s Law

98

1. Record the mass of the mass hanger, my = 50.0 g, in your data sheet.

2. Measure the rest length (nothing on the end) of the spring and record
it in your data sheet.

3. Attach the empty mass hanger to the spring and measure the position
Xp of the end of the spring with the zero end of the meter stick on
the table. Be sure to include a reasonable uncertainty.

4. Increase the total mass on the end of the spring to 120 g (this includes
the mass of the hanger). Measure the height of the spring now and
record it in your data sheet.

5. Increase the mass by 10 g increments, making sure to measure and
record the height at each step, until you reach 220 g.

6. Calculate Am =m —mpg, AX = X — X, 0(X — Xg) = 20X, and
Fg = —kAX = Amg (we are measuring the distances when the spring
is in equilibrium) for each trial on your data sheet.

7. Graph Fg vs. AX in KaleidaGraph. Include horizontal error bars
and a best fit line. If you have a straight line, this verifies Hooke’s
Law already. Here, the slope will tell you the spring constant and it’s
uncertainty.

Part II: Period of Oscillation

1. Set the photogate to the PEND setting.

2. Starting at a mass of 120 g on the end of the spring, measure the period
of oscillation by causing the masses to oscillate through the photogate.
You can adjust the height of the photogate and the height of the spring
to allign the equilibrium position with the photogate. When displacing
the mass for oscillation, this should be a small displacement; do not
stretch the spring more than 5 cm. Do this in 20 g intervals up to 220

g.
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3. Calculate the mass of the spring using the given spring density and
the rest length of the spring. Record this value in your data sheet.

4. Calculate 72 in Excel for each trial.

This gives us an equation in the same form as a straight line y = max+b
with intercept b = 0. The value m in Equation 9.4 is the total mass
felt by the spring.

5. Calculate the total mass using the formula m = mg +m +
in Excel. Note that this is a different m than you used in Part 1. Here
the total mass experienced by the spring is the mass of the hanger,
the masses added to the hanger, and 1/3 of the mass of the spring.

spring mass
e

6. Make a plot of 72 vs. m in KaleidaGraph. Be sure to include a best fit
line on this plot. In the question you will use the slope of your graph
to find the spring constant. Note that squaring both sides of Equation
9.3 we get

4 2
= ——m (9.4)

9.8 Checklist

1. Excel Sheets
2. Plot of Fg vs. AX
3. Plot of 72 vs. m

4. Questions
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9.9. Questions

9.9 Questions

1. Is your data consistent with Hooke’s Law? Specifically, is the spring force
linearly dependent on how much the spring is stretched? Is it a restorative
force? Why or why not? From the slope of your graph, what is the spring
constant and it’s uncertainty?

2. Calculate the spring constant and its uncertainty using the information
obtained from your graph of 72 vs. m. Hint: The fractional uncertainty

in the spring constant is equal to the fractional uncertainty in the slope

((S_k _ 5slope)
k — slope /*
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9. THE SPRING: HOOKE’S LAW AND OSCILLATIONS

3. You obtained the spring constant in two independent ways. Discuss the
consistency of your two measurements of the spring constant. If they are
not consistent, suggest a possible source of error.

4. When a mass m is attached to a spring it exerts a force W = mg on the
spring and the length of the spring is changed by Ax. If the single spring is
replaced with a) two identical springs in series, what happens to AZgeries
compared to the case of a single spring? b) If the single spring is replaced by
two identical springs in parallel, what happens to Ax,pa11¢1 compared to the
case of a single spring? Assume all springs have the same spring constant
and always compare to the single spring case. Answer each question by
stating if Ax increases, decreases or remains unchanged. Also, what are
AZgeries and Azparaiiel in terms of Az for the single spring case? Hint:
draw a force diagram of the system — the net force on the mass must be
ZEero.
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Experiment 10

Vibration Modes of a String:
Standing Waves

10.1 Objectives

e Observe resonant vibration modes on a string, i.e. conditions for the
creation of standing wave patterns.

e Determine how resonant frequencies are related to the number of nodes,
tension of the string, length of the string, and string density.

e Determine the velocity of transverse waves in the string.

10.2 Introduction

Everything you can see is due to waves. A wave is defined as an oscillation
through space. The reason we can see things is because photons oscillate
through space in the form of a wave and enter our eyes. This sends a signal
to our brain and thus we can see. Today we will investigate waves on a
much large scale. When you apply an oscillation to the end of a tight string,
it begins to form waves with given frequencies. The resonant frequency
is the frequency at which the wave oscillates freely without constructive
interference adding to its amplitude.

105
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10.3 Key Concepts

As always, you can find a summary on-line at Hyperphysics.! Look for
keywords: standing waves on a string, resonance, transverse waves

10.4 Theory

A wave in a string can be characterized by its wavelength, A, just like
a sound wave or a light wave. For a string that is fixed on both ends, a
standing wave can develop if an integer number of half wavelengths fit
into the length, L, of the string:

n (%) — L (10.1)

Here n refers to the number of maxima (also called antinodes) in the
wave pattern as demonstrated in Figure 10.1. The resonant frequency,

fn, for wavelength X\, with wave speed ¢ is?
c
= — 10.2
fo= o (10.2)

Combining equations 10.1 and 10.2 we obtain:

c
o= <Z> n (10.3)

If a force acts on a string with a resonant frequency, the amplitude of
the vibration will grow very large. This is a common behavior in many
physical systems. An example of such behavior is pushing a child on a swing.
A swing oscillates with a characteristic frequency. If someone exerts a
push on the child with that frequency, after several cycles the amplitude of
the swing becomes large, even if the pushes are gentle. If pushes are given
with a different frequency, some of the pushes will be out of phase; meaning
that the child will be pushed against his motion and the amplitude will

lhttp://hyperphysics.phy-astr.gsu.edu/hbase/hph.html

2The pitch of musical instruments is determined by the resonant frequency, whether it
is a string instrument, a wind instrument or a percussion instrument. Since instruments
are not driven at a fixed frequency, the vibrations are composed of a mixture of several
harmonic frequencies.
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10.4. Theory

n - number of anti-nodes
=
[
rJ

Figure 10.1: Three lowest characteristic frequencies of a string (with n = 1,2
and 3 maxima).

not have a chance to grow. A string has many characteristic frequencies
and the string’s amplitude will grow whenever the driving force has any of
these characteristic frequencies. If a string is set to vibrate at one of these
characteristic frequencies a standing wave is set up on the string. When a
standing wave is present, nodes and antinodes will be visible on the string.
A node is a location on the string where the string does not move. On
the other hand, an antinode is a location that undergoes a vibration with
very large amplitude. Figure 10.1 shows the lowest three characteristic
frequencies for a given string under constant tension.

The speed, ¢, of a transverse wave in a string depends on the string’s
mass per unit length p and the tension 7' (p is the Greek letter rho and is
frequently used to represent mass density). By setting the tension with the
pulley system shown in Figure 10.2 and by measuring the mass density, one
can determine the speed of the transverse wave by

T
Ps
The fractional uncertainty in the stretched string density is
) ol ol
9Ps _ (_s n —0) (10.5)
Ps Ls lo
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10. VIBRATION MODES OF A STRING: STANDING WAVES

Here, Iy and [g are the respective lengths of the string when it is un-
stretched and stretched. Both of these quantities are required to calculate p.
The uncertainty of the unstretched string dlj includes both the uncertainty
in reading the meter stick and the uncertainty associated with aligning the
unstretched string with the meter stick (the string needs to be in a straight
line and at the same time not stretched). Similarly, the uncertainty of the
length of the stretched string dlg includes both the uncertainty associated
with reading the meter stick and the uncertainty of aligning the meter stick
with the string. In this case, the string changes directions as it passes over
the pulley as shown in Figure 10.3. You should make reasonable estimates
of both of these uncertainties.

The fractional uncertainty in the speed ¢ found by equation 10.4 is given
by:

be_ Lo (10.6)
¢ 2 ps
Because the fractional uncertainties in the string’s mass and the tension in
the string are both small compared to the fractional uncertainties of /j and
ls, they are not included in the fractional uncertainty equation 10.6.
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Frecle

T=mg

Figure 10.2: Diagram of how the string looks when driven at the second
lowest resonant frequency. This configuration has two anti-nodes (points of
maximum oscillation).

10.5 In today’s lab

Today we will investigate the wave speed traveling through a string under
tension in 3 ways. First we will find the resonant frequencies of the string
for 1-11 antinodes. We will then calculate the wave speed using Equation
10.3 for each resonant frequency and average the values together. Next, we
will calculate the wave speed using Equation 10.4. Finally, we will plot our
results and use the graph to measure our wave speed. We will then see
whether or not all 3 methods are consistent with one another.

10.6 Equipment

e Variable Frequency Oscillator
e Pulley and Weight System

e String
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Figure 10.3: Diagram showing the experimental apparatus.

e 2 Meter Stick

e Mass Scale

10.7 Procedure

1.

110

Measure the rest length [y of the string and record it in your data
sheet.

Measure the mass of your hanger and mass system and record it in
your data sheet.

. Attach the mass system to the end of your string and hang it over the

pulley. Measure the length L (see Figure 10.2) and record it in your
data sheet. L should be approximately 150 cm.

Measure the total stretched length of the string with your mass
system hanging on the end and record it in your data sheet. Using
this value, calculate the stretched string density using the density of
the unstretched string, pg = (mg/lp) = 0.0375[g/cm].
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10.

11.

12.

13.

Using Equation 10.4, T' = mg, and pg, calculate the wave speed and
record it in your data sheet.

Position the oscillator near the fixed end of the string and adjust the
oscillator to “Hz 1-100".

Starting around 100 Hz, find the first frequency mode where you have
11 antinodes in the string. Be sure to finely adjust the frequency until
you get the largest possible peaks. Record this frequency in your data
sheet.

Gradually decrease the frequency until you find the next lowest integer
of antinodes (n = 10 in this case) and record the frequency in your
data sheet.

Repeat step 8 for n = 9 to n = 1 antinodes. Then using equation. 10.1
to find Aj,.

Using the formula ¢, = A\, fn, calculate the wave speed for each
resonant frequency in Excel and calculate the mean value of this speed.
You may use the formula “=AVERAGE(E23:E33)” for this calculation.

In Excel, calculate the standard deviation and standard deviation of the
mean for your resonant frequencies as well. For the standard deviation,
you may use the formula “=STDEV (E23:E33)”. The standard deviation
of the mean, s, = s/v/N will be your uncertainty for this wave speed
calculation (N = Number of Trials).

Make a plot of f;, vs. n in KaleidaGraph and include a best fit line.
You do not need error bars for this plot.

Answer question # 2 and fill in the respective cell in Excel before you
print your Excel sheets.

10.8 Checklist

1.
2.
3.

Excel Sheets
Plot of fy, vs. n

Questions
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10.9 Questions

1. What is the slope of your graph and its uncertainty?

2. From the slope and uncertainty of the slope, calculate the speed of the wave

and its uncertainty. Hint: dc = ¢ (ﬁfgee + %)
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10. VIBRATION MODES OF A STRING: STANDING WAVES

3. Is the speed of the wave measured from your graph consistent with the mean
value of your eleven ¢ = A, f;, calculations?

4. Is the speed of the wave measured from your graph consistent with the value
you obtained using Equation 10.47
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Appendix A

Dealing with uncertainty

A.1 Overview

e An uncertainty is always a positive number dx > 0.

e If you measure x with a device that has a precision of u, then dx is at
least as large as wu.

e Fractional uncertainty:

— If the fractional uncertainty of x is 5%, then dx = 0.05z.

— If the uncertainty in x is dx, then the fractional uncertainty in x
is oz /.

¢ Propagation of uncertainty:
—Ifz=x+yorif z=2x—y, then
0z = dx + dy. (A1)

— If z=ay orif z = z/y, then
oz dx oy

T 4 (A.2)
EAR el 7]
— For f = 2"y™2P, where n, m, and p are exact,
) ) ) )
of _ n= +mY +p—Z (A.3)
f x y z
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— For an arbitrary function f(z),

0f(x) = |f(x+dx) — f(x)| (A.4)
as long as dr < .
e Percent error. If d is data and e is the expected value, the difference,

D, is
D=d-e. (A.5)

The percent error is given by

D
% error = — X 100% (A.6)

They are compatible if |d — e| < dd + de, that is they are compatible
when their difference is equal to 0 with the uncertainty of the difference.

A.2 Concise notation of uncertainty

If, for example, y = 1234.567 89 U and dy = 0.000 11 U, where U is the
unit of y, then y = (1234.567 89 + 0.000 11) U. A more concise form of this
expression, and one that is in common use, is y = 1234.567 89(11) U, where
it is understood that the number in parentheses is the numerical value of
the standard uncertainty referring to the corresponding last digits of the
quoted result. This explanation is from Ref. (Mohr 2011).

A.3 Significant figures

There is no actual information carried by figures which represent values
much smaller than the uncertainty of a measurement. For example, if you
do a calculation and your calculator, or Excel, gives you z = 12.3456789,
but when you calculate the uncertainty, you get dx = 0.01234, according to
the previous section you would naturally write this as

12.346(12).

This is because there is hardly ever justification for reporting an uncertainty
to more than 2 figures (so that 0.01234 should be reported as just 0.012).
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Therefore the decimal places in & beyond the reported uncertainty are
obviously carrying information corresponding to a tiny fraction of your actual
knowledge of z (i.e. much smaller than dz). Thus 12.3456789 — 12.346
since the last reported position in the uncertainty is 0.012, 3 figures to the
right of the decimal point; and in the reported x value, the trailing 56789
would be rounded up to 6.

A.4 Using uncertainties to compare data
and expectations

Simple Measurements: The smallest division estimate

Suppose you use a meter stick ruled in centimeters and millimeters, and you
are asked to measure the length of a rod and obtain the result Ly = 5.73 cm,
seen in Fig. A.la. A good estimate of the uncertainty here is half the
smallest division on the scale, 0.05cm. Thus, the length of the rod

would be specified as
Lo =5.73+0.05cm. (A.7)

This says that you are very confident that the length of the rod falls in the
range 5.73 cm—0.05 cm to 5.73 cm+0.05 cm — that is, the length falls in the
range of 5.68 cm to 5.78 cm, as in Fig. A.1b.

Manufacturer’s tolerance

Suppose I purchase a nominally 100 €2 resistor from a manufacturer. It has
a gold band on it which signifies a 5% tolerance. What does this mean?
The tolerance means JR/R = 0.05 = 5%, that is, the fractional uncertainty.
Thus, 6R = R x 0.05 = 5. We write this as

R = Rpominal = 6R = 100 £ 5. (A.8)

It says that the company certifies that the true resistance R lies between
95 and 105€2. That is, 95 < R < 105€2. The company tests all of its
resistors and if they fall outside of the tolerance limits the resistors are
discarded. If your resistor is measured to be outside of the limits, either
(a) the manufacturer made a mistake, (b) you made a mistake, or (c) the
manufacturer shipped the correct value but something happened to the
resistor that caused its value to change.
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A. DEALING WITH UNCERTAINTY

readimg 5.73 cmn reading 5.73 cm
L N
| | | | | |
56 5.7 58 5.6 5.7 5.8
568 cm 5.78 cm
Figuwre 1la Figure 1b

Figure A.1: Measuring a length with a ruler. If the value is read as in (a),
then a reasonable uncertainty is show in (b).

Reading a digital meter

Suppose I measure the voltage across a resistor using a digital multimeter.
The display says 7.45V and doesn’t change as I watch it. The general rule
is that the uncertainty is half of the value of the least significant
digit. This value is 0.01 V, so the uncertainty is half of it — 0.005 V. Here’s
why: The meter can only display two digits to the right of the decimal, so it
must round off additional digits. So if the true value is between 7.445V and
7.454 V| the display will get rounded to 7.45,V. Thus the average value and
its uncertainty can be written as 7.45 £ 0.005 V.

When you record this in your notebook, be sure to write 7.45V. Not
7.450 V. Writing 7.450 V means that the uncertainty is 0.0005 V.

Note that in this example we assumed that the meter reading is steady.
If, instead, the meter reading is fluctuating, then the situation is different.
Now you need to estimate the range over which the display is fluctuating,
then estimate the average value. If the display is fluctuating between 5.4
and 5.8V, you would record your reading as 5.6 & 0.2 V. The uncertainty
due to the noisy reading is much larger than your ability to read the last
digit on the display, so you record the larger error.
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A.4. Using uncertainties to compare data and expectations

Using uncertainties in calculations

We need to combine uncertainties so that the error bars almost certainly
include the true value.

Adding and subtracting

Let’s look at the most basic case. We measure x and y and want to find the
error in z.
If 2 =24y, then
dz = dx + dy (A.9)

If z=x —y, then
0z = 6x + dy (A.10)

Note that the uncertainty for subtracting has exactly the same form as
for adding.
The most important errors are simply the biggest ones, since they impact
the precision of your result the most.
Example:
(T+1kg) — (5t 1kg) =2+ 2kg (A.11)

Multiplying and dividing
If a = be, then

oa O0b dc
; = ? + ? (A12>

For dividing, if w = z/y, the rule is the same as for multiplication;

bw _ oz, 0y (A.13)
w x Yy

It is simplest to just remember the single boxed rule, Eq. A.12, for
multiplication and division.

If the expression contains a constant, the uncertainty of that constant is
zZero.

The most important errors in multiplication and division are the largest
fractional errors, not absolute errors. This makes sense if you consider that
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A. DEALING WITH UNCERTAINTY

b and ¢ need not have the same units — there is no way to compare the
absolute sizes of quantities with different units.

Example:
V=IR
I =7+1mA
R=20+20Q (A.14)

V =140 (mA - Q) = 140mV = 0.14V

The uncertainty is given by

8V 0 6R
VT R
1mA 20
~ 7mA 200
= 0.24 (A.15)

§V =10.24 x (0.14V)
=34mV

Our formula for multiplication indicates that multiplying by a perfectly
known constant has no effect on the fractional error of a quantity. For exam-
ple, the speed of light in vacuum, ¢, is 299 792 458 m/s with no uncertainty.!
If we measure the time it takes for light to travel as 12 + 1s, then we can
find the distance that it traveled.

¢ =299792 458 m/s t=12+1.5s

d=ct
d = (299792458 m/s) x (12s) (A.16)
d = 3597 509 496 m

!This is because the meter is defined as the distance light travels in 1/299 792 458
seconds in a vacuum.
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The uncertainty is given by

sa_oe ot
d ¢ t
Om/s 1.5s
g A..].
299 792 458 m//s - 125 (A.17)
15
12

and thus d = 3597509496 + 449 688 687 m. Note that the value of the speed
of light did not matter in the calculation of the fractional uncertainty, since

it was multiplied by its zero uncertainty.
ot ot
The uncertainty dd = d7 = ct7 = cit.

So, dd is just the constant ¢ times dt.

Multiples

If f=cx+ dy—+ gz, where ¢, d, and g are positive or negative constants,
then from the multiplication rule, we find that

d(cx) = |cox|
5(dy) = |y (A.15)
d(gz) = |goz|
From the addition rule,
Of = |cdz| + |doy| + |goz| (A.19)

Powers
If f=aPylz", where p, ¢, and r are positive or negative constants,

of d(P) d(y?)  d(2")
F I R

(A.20)

and thus
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) 0
x

; (A.21)

General formula

Suppose we want to calculate f(z), a function of x, which has uncertainty dzx.
What is the uncertainty in the calculated value f? We simply calculate f at
x, and again at ' = x + 0z, then take the absolute value of the difference:

of = |f($/) — f(z)|, where v’ =+ 6z (A.22)
For example, if f(z) = sinz, and x = 30 £ 1°, then
df = [sin(31°) — sin(30°)

= 0.515 — 0.500| (A.23)
=0.015

What happens when there is more than one variable? We do the calcu-
lation for each variable separately and combine the resulting uncertainties:

When are errors negligible?

Errors are only negligible in comparison to something else and in the context
of a particular calculation. So it’s hard to give general rules, but easier for
specific cases. Here’s an example of how to think about this question.

You measure a long thin ribbon (that is, something rectangular). Its
length is 10 4 0.02 m, and its width is 2 4+ 0.1 cm. Which uncertainty is more
important? The answer depends on what you want to calculate.

First, imagine that you are feeling festive and want to border the ribbon
with glitter. To know how much glitter you'll need, you must find the length
of the perimeter P of the rectangle formed by the ribbon. The perimeter is
given by

P=2(L+W). (A.25)

We apply our addition rule:
0P =2(6L + 0W). (A.26)
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Now, 6L = 0.02m and 0W = 0.1cm = 0.001 m. Since 6L is 20 times the
size of )W, we can neglect )W — that is, ignore it. Note that we had to
put 6L and 0W into the same units to compare them: 0.02m is much larger
than 0.2 cm.

Now, imagine that instead of just the border, you want to cover the
entire area of one side of the ribbon with glitter. For this you need to find
the area, A, of the ribbon.

A=LW (A.27)
The multiplication rule gives
o4 _ oL oW
A L W
0.02 0.1
_ m + cm (A.28)
10m 2.0cm
= 0.002 + 0.05

In this case, the uncertainty due to 0L is negligible compared to that from
O0W , the opposite conclusion as for the perimeter calculation! That’s because

oL
we are multiplying and now need to compare not 0L vs 0W, but instead T
ow

VS —-.

w

Using uncertainties to compare data and expectations

One important question is whether your results agree with what is expected.
Let’s denote the data by d and the expected value by e. The ideal situation
would be d =€, or d — e = 0. We'll use D to denote the difference between
two quantities:

D=d-e (A.29)

The standard form for comparison is always (result) — (expected), so that
your difference D will be negative if your value is lower than expected, and
positive if it is higher than expected.

This comparison must take into account the uncertainty in the observa-
tion, and perhaps, in the expected value as well. The data value is d £ dd
and the expected value is e £ de. Using the addition/subtraction rule for
uncertainties, the uncertainty in D = d — e is just

5D = dd + de (A.30)
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Our comparison becomes, “is zero within the uncertainties of the difference
D?7” Which is the same thing as asking if

ID| < 6D (A.31)

Eqgs. A.30 and A.31 express in algebra the statement “d and e are compatible
if their error bars touch or overlap.” The combined length of the error bars
is given by Eq. A.30. |D| is the magnitude of the separation of d and e. The
error bars will overlap (or touch) if d and e are separated by less than (or
equal to) the combined length of their error bars, which is what Eq. A.31
says.

Example

Now we have all we need to do comparisons. For example, if we measure a
length of 5.9 £ 0.1 cm and expect 6.1 + 0.1 cm (measured by the TA), the
difference is
D=d-—e
=5.9cm — 6.1 cm (A.32)

= —0.2cm
while the uncertainty of that difference is

dD = od + de
=0.1cm+ 0.1cm (A.33)

=0.2cm

We conclude that our measurement is indeed (barely) consistent with ex-
pectations. If we had instead measured 6.4 cm, we would not have been
consistent.

A good form to display such comparisons is:

d [em] 40d [em] e [ecm] de [em] D [em] D [em] compatible?

5.9 0.1 6.1 0.1 —-0.2 0.2 YES
6.4 0.1 6.1 0.1 +0.3 0.2 NO
6.2 0.2 6.1 0.1 +0.1 0.3 YES
6.4 0.2 6.1 0.0 +0.3 0.2 NO

If only one comparison is to be made, your lab report might contain a
sentence like the following: “The measured value was 6.4 + 0.2 cm while the
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expected value was 6.10 + 0.0 cm, so the difference is +0.3 £ 0.2 cm which
means that our measurement was close to, but not compatible with, what
was expected.”
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Appendix B

Spreadsheet Commands

Table B.1: List of Spreadsheet commands

Operation or Function = Mathematical Description Command
addition 11412 =11+12
subtraction 29 —21 =29-21
multiplication 30 x 15 =30%15
division 44/12 =44/22
(combination of above) 3+ 5;:2 —3x7 =3+4/ (5%2) - (3%7)
square root V5 or /7 x (5/3) =sqrt(5) or
=sqrt (7*5/3)
power 63 or 795 =6"3 or 77(0.5)
the constant “pi” s =pi()
sum of numbers > a; =sum(...), where ...
can be a list of cells
(example of sum) Al + A2+ A3 =sum(A1,A2,A3) or*

=sum(A1:A5)

127

Continued on next page
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Table B.1 — continued from previous page
operation or function mathematical description command
mean value (A1 + A2+ A3)/3 =average (A1:A3)
=\2
T, — X
standard deviation % =stdev (series of cells)
sine sinz or sin(27x) =sin(x) or
=sin (2*pi () *x)
cosine cos T =cos(x)
arctangent (inverse tangent) arctanz or tan” !z =atan(x)

* This second option can be used when the spreadsheet command ref-
erences cells in the same column and adjacent rows, or in the same row
and adjacent columns. You can also combine methods of defining cells. For
example, if you wanted to find the sum of the contents of cells B3 through
B28, B32, and B40 through B100, the spreadsheet command you would use
is =sum (B3:B28,B32,B40:B100)

Some other useful hints

e If in doubt, use parentheses to make sure things get calculated in the
right order. For example, =3+5/2 results in 5.5. But, =(3+5) /2 results
in 4. In the first case, it would be better to use =3+(5/2) in your
spreadsheet program.

e Pushing the Ctrl+¢ keys will display the formulas for the entire
spreadsheet (the backquote (‘) is to the left of the number 1 on the
US keyboard). Pressing these two keys again reverts back to the
calculated numbers.
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Appendix C

Physical Constants

Name Symbol Value(uncertainty)
electric constant €0 8.854 187 817... (exact)x10” F m~!
elementary charge e 1.602 176 565(35) x 10719 C

Planck constant h 6.626 069 57(29) x 10734 J s

speed of light in vacuum c 2.997 924 58 (exact)x10% m s~
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Appendix D

Contents of a Lab Report

This is a general list of items and sections which should be included in every
lab report.

Data and Spreadsheet

Write your name and your lab partner’s name at the top of your
spreadsheet.

The spreadsheet should have the data columns labeled, including
units. Also, include a written sample calculation for each type of
calculation performed by Excel. Do not forget to include the equation
or constants used.

Include any additional calculations that the lab manual asked you to
do.

Include a print-out of the formula view of your spreadsheet; to go to
formula view: Ctrl+*

Fit Excel sheet to one page: go to File » Page Setup » Scaling:
Fit “1” page wide by “1” page tall.

Graphs

Along with every graph there needs to be an observation (~ 2 sentences)
as to the nature of the graphs. You could comment on how the curves
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behave, what interpretation can be drawn from them, etc. What can
we learn from this graph, or what message do you have for your reader
about it?

e Every graph should have the following:

13

. title (always “ ‘vertical axis’ vs. ‘horizontal axis’ ")

1

2. labeled axes with units

3. curve fit if appropriate

4. legend if needed

5. error bars when appropriate
6

. your observations

e An example of a graph is shown in Fig. D.1
Answers to questions
e Tear out the question pages and provide answers to them.

Ordering of Pages

1. Data (sample calculations, spreadsheets, formula view)

2. Answers to questions
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Volune of water leaked through roof vs. time

Volume (L)

: m1 0.17086 | 0.011629

m2 | 0.0084286 | 0.0002558

LR S S S poreme -] chisq | 0.0059543 NA |
' § : R| 099407 NA
0.1 i i i | | ] |
0 10 20 30 40 50 60 70 80
Time (sec)

Figure D.1: The graph represents the volume of water leaking through a roof
versus time. The rate at which water penetrates the roof is 0.0084+0.003 L /s.
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